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Connect+ is enterprise management software designed to monitor your store or region performance in real time. Currently 
Connect+ supports Copeland Controllers E2, Site Supervisor, and XWEB.

This document provides a step-by-step guide for Store Managers or Monitoring Technicians on how to use Connect+ to 
monitor your stores or regions. The following topics are included in this user guide:

•	 How to use an Advisory Map to locate your problematic sites.

•	  How to locate sites that are not sending alarms.

•	 How to diagnose advisories.

•	 How to review Live Advisories from controllers.

•	 How to monitor stores in real time and compare store/device performance.

•	 How to access controllers and schedule jobs to read data.

•	 Tips to process Live Advisories.

•	 How to override and manual defrost.

•	 How to search a site, a controller or a device in your enterprise.

•	 Review Enterprise Summary including stores, controllers and devices information.

•	 How to export store data

1.1   Terminology

•	 Advisory: Alarm/Notice generated from controller, or notification from Connect+.

•	 Graphical Screen: Floor Plans or Summary Screens for real time store monitoring.

•	 Tree Hierarchy:

	» Directory: A region or a banner of a customer.

	» Site: A store in a region or banner.

	» Control System: A set of controllers within one store.

	» Unit: Controller.

	» Application Type: The type of application that has been set up inside a unit (controller) Example: AHR, Circuits, Condenser, Lighting 
Schedule, User Access are all App Type.

	» Application: Apps are programmed inside a controller to access a physical device or define the controller setting.

	» Point: Application’s data attributes.

•	 Activity: A job that a user conducts to access the controller.

	» Obtain Controller Information: Obtain controller hierarchy including every controller, application, and points.

	» Refresh Unit: Refresh controller Information.

	» Refresh Application: Refresh the applications of a controller.

	» Refresh Point List: Refresh all the points of an application type/application.

	» Retrieve Logs: Get log data from one or multiple points.

	» Manual Defrost: Defrost a freezer manually.

	» Override/Modify: Change a Point Value.

	» Display Log/Real Time Graph: Display log graph or real time graph for a specific point.

1.   General Information
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2.   Logging into Connect+

2.1   Log In with Connect+ User

Before logging into Connect+, contact your manager or IT 
department to obtain your Connect+ login credentials.

If you have forgotten your Password or Login ID, click 
Forget Password or Forget Login ID. You must have a 
valid email in your user profile with Connect+ in order to 
receive the temporary password or Login ID.

Connect+ Login

Connect+ Login

If your company has enabled complex password, you might 
need to reset your password when first login or when your 
password is about to expire.

Reset Your Password

2.2   Log In with Single Sign-on

If the company enables the Single Sign-on, the company 
user can log into the Connect+ with the company 
credential.

In the login page, you will see a Login with XXX (XXX is 
the IDP Name which is configured in SSO configuration) 
button.

Connect+ Login with Single Sign-on

Click Login with XXX button to be redirected to company 
IDP Login page.

Single Sign-on Login
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Input the company username and password then click the Sign In button. For the first time login, you will be redirected to 
the Connect+ user binding page after logging in to the company credential. The propose of this is to associate the Connect+ 
user with your company IDP user. After association, the existing Connect+ user’s properties, like privilege, site permission, 
customized GS screen, will be assigned to the company IDP user.

Single Sign-on User Binding

Input Connect+ Login ID and Password, then click the Login button to log into the Connect+ successfully. If you do not have a 
Connect+ account, click the Don’t have a Connect+ Account? link under Login button.

The Connect+ user will automatically create an account with your First Name, Last Name and Email which is configured in IDP 
Server. You can also modify your user profile after login. Click the OK button in the pop-up message to log into the Connect+. 
After the Connect+ user is automatically created, you will be assigned with basic privileges and no site permission is assigned, 
contact your administrator to adjust it.



4026-1020 R3 Connect+ User Guide ©2024 Copeland LP.

3.   Navigate Connect+

Once logged in, you will see the Connect+ UI is designed 
with four areas. 

•	 Area 1 contains main toolbar icons for you to access 
Enterprise Level Information, such as alarms, sites without 
alarm connection, Store/ Device Summary, Schedule Jobs, 
Global Search etc.

•	 Area 2 is the Navigation Tree, which is set by your 
Administrator to reflect your Enterprise Hierarchy. The 
navigation tree starts from the Directory level, which reflects 
the region or banner you belong to, then the Site level, 
which reflect your stores. Under each store, you can review 
the controllers installed, down to the devices the controller 
controls and device attributes. When you right-click on each 
level in Navigation Tree, you will see the Right-Click Menu, 
which is provided to review information or perform activities to 
access controllers.

•	 Area 3 is the Context Menu, which is associated with your 
Navigation Tree level. The Context Menu is same as the Tree 
Right-Click Menu.

•	 Area 4 is the major Review area. When you click the enterprise 
toolbar and Navigation Tree rightclick menu or context menu, 
the information or controller activity progress/result would be 
displayed in this area.

Navigation Panel

3.1   Connect+ Enterprise Toolbar  
Navigation

Advisory

Count indicates the Total Number 
of Active Alarms in the Past 24 
Hours. Users will be directed to View 
Advisories upon selecting.

Sites without 
Connection

Count indicates the total number of 
sites without connection in the past 
24 Hours. Users will be directed to 
the Connection Verification Report 
upon selecting.

Homepage
Users will be directed to their 
own Connect+ Homepage once 
preferences are set.

Enterprise 
Summary

Enterprise Summary contains region, 
site, controller, and device information.

Header Menu

Access to Schedule Manager and 
Activity History to

•	 Schedule different activities to 
execute job on the controller.

•	 View activity result and detail.

Language 
Setting

Allow user to change Language 
Setting

Global Search
Offers Global Search for your Site 
Homepage and global search for any 
sites, controller, devices, or points.

NOTE: Details about Advisory Map, Advisory View, 
Site without Connection, List Power Builder, Schedule 
Manager, Enterprise Summary and Global Search would 
be covered in later sections.

Toolbar Navigation

Table 1: Toolbar Navigation Legend
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Application Instance

An application instance shows the application (if available) 
that has been programmed inside a controller to access a 
physical device or define the controller setting. Through 
the application instance, users can either access a physical 
device’s data points, such as an ice cream case controller. 
Or access to applications that are programmed to configure 
the controller, such as user access or alarm settings.

Point

Application points are attributes that have been 
programmed inside a controller application. Access to 
application points allows the user to view details about the 
points, graph points, retrieve logs, and make changes. In 
Connect+, there are three categories of points: Input, Output 
or Parameters.

An input point can be associated with an output point of the 
same data type, and vice versa (for example, digital outputs 
to digital inputs, analog inputs to analog outputs). An input 
point cannot be associated to another input point, likewise, 
an output point cannot be hooked to another output point.

Application Types

3.2   Store Hierarchy by Navigation Tree

As you can see from the Navigation Tree of Connect+ 
landing page interface, a store hierarchy is reflected by  
the Tree listed with the concept of Directory, Site,  
Control System, Unit, Application Type, Application and 
Point. 

3.2.1   Definition of Tree Hierarchy 

Directory

Directory is a region or a banner of a customer. Connect+ 
offers a sub-directory under the parent directory to reflect a 
customer’s own organization structure.

Sites

Sites are stores in a customer’s organization. One site 
belongs to only one Directory.

Control System

A control system is a set of controllers within one localized 
store. A typical grocery store control system would contain 
building management controllers and refrigeration 
controllers.

Unit

A unit is an individual controller at a site belonging to a 
control system. There may be more than one unit in each 
control system. One controller would be configured as 
the gateway in the control system to communicate with 
Connect+.

Application Type

An application type is the type of application that has been 
set up inside a unit (controller). There are many types of 
applications programmed into the controller. All application 
types contain applications that belong to the same 
application type.

Forget Password

Application types ranges from physical applications that 
connect to a real device, such as air handlers, standard 
circuit, sensor control analog and digital combiners.

Or logical applications such as zones, power monitoring, 
global data, time and dates, time schedules, user access 
and more.

See below for a REF Controller Application Types and 
Building Controller Application Types examples:
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•	 Active Points is the default each time the user starts up the browser and will show all configured points in the controller.

•	 Active with Logs shows active points that have a controller log available.

•	 Points with Logs shows points that have a controller log available.

•	 All Points shows all possible points for an application instance, whether a point is configured or not. An icon will appear next to the point 
if the point has a log.

3.2.2   Tree Levels
•	 Advisory View: At any level, you will have access to Advisory View, which allows you to review advisories for a region, store, controller, or 

device.

•	 Graphical Screens: You can also access different summary information at each level, which is illustrated as System Graphical Screens.

•	 Controller Access: You can only access a controller at the control system level and controller level. From the controller level, you can 
remote login using Terminal Mode.

•	 Controller Activity: you can perform three types of job at different levels:

	» Any Level: Retrieve logs

	» Directory/Site/Control System/Controller Level: Obtain controller information

	» Controller Level: Refresh application

	» Application Type Level: Refresh point list

	» Application Level: Manual defrost freezer or cases

	» Point Level: Override/modify point value, display log/real time graph

Active Points
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Tree Level System Screens Controller Activity Controller Access

Directory Advisory Map
Obtain Controller Information
Retrieve Logs

NA

Site
Ref Summary
Building Summary
Other Summary

Obtain Controller Information
Retrieve Logs

NA

Control System NA
Obtain Controller Information
Refresh Units
Retrieve Logs

View Network Status

Unit Controller Summary
Obtain Controller Information
Refresh Units
Retrieve Logs

Terminal Mode
View Network Status
Controller Logs & Status

App Type
App Summary
Defrost Summary

Refresh Point List
Retrieve Logs

NA

Application
Status
Graphical Summary

Refresh Point List
Retrieve Logs

NA

Point NA

Override
Modify
Display Log Graph
Real Time Graph

NA

Table 2: Tree Levels

Top Menu  Tree Right-Click Menu
Graphical Screen
Right-click Menu

Watch Point  
Right-click Menu

Advisory View Enterprise Any Level Point Level Point Level

Run Once or 
Schedule

Only Run Once from Right-Click 
Menu

Activity

From Schedule 
Manager, user can 
choose Run Once or 
Run by Schedule

Retrieve Logs
Obtain Controller Info
Refresh Units
Refresh Application
Refresh Point List
Manual Defrost
Override
Modify
Display Log Graph
Real Time Graph

Retrieve Logs
Override
Modify
Display Log Graph
Real Time Graph

Retrieve Logs
Override
Modify
Display Log Graph
Real Time Graph

3.3   Menu Access Summary

In addition to the top menu and tree hierarchy right-click menu, you can also access the right-click menu from the Graphical 
Screen or Watch Point Lists.

Below table summarizes menu access for advisory and controller activity at each entry point:

Table 3: Menu Access Summary
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3.4   Complete My Profile and Set Preference

Complete Email

If you do not currently have an email, we recommend you enter that information. Without email information:

•	 You cannot receive emails from Connect+ when you forget a password or forget the login ID process.

•	 You also cannot receive the verification code during login if your organization decides to turn on Multifactor Authentication.

Updated Password

If your organization has activated Reset Password Every 90 days, you will be reminded to update your password when your 
current password is expiring within 14 days.

Setting Preferences

•	 Show GS Screen Edit Tool: This allows GS Screen menu visible on the right-click tree menu, default is not enabled.

•	 Enable Home Page: This allows you to set your Connect+ Homepage, default is not enabled.

•	 Hide Nav Frame: This allows you to hide the Navigation Tree. Default is a visible Navigation Tree.

•	 Enable GS Screen Auto Logout: This allows you automatically logged off due to GS Screen page inactivity for 30 minutes.

•	 Engineering Units: English/Metric/Global; default is set to English Units.

User Info

Update Your Password

3.4.1   Profile & Preference

You might want to check your User Info to complete and set 
preferences. Click the icon next to your name and then click 
User Info.
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•	 You can set your language preference directory from the 
enterprise toolbar. Currently you can choose English or 
Spanish.

Enable GS Screen

Language Preference

3.4.2   Set Connect+ Homepage

When you enable the Homepage setting, you will see the Set as Homepage menu option when you click the user profile icon 
next to your name. Currently Connect+ allows you to set Graphical Screens as your Connect+ Homepage.

We recommend you set the Enterprise Advisory Map as your Connect+ Homepage to better optimize your Enterprise overall 
performance.

If Advisory Map has been enabled for your organization, you can access Advisory Map at the Directory level. Click your 
organization’s parent directory, or access from right-click menu > Advisory Map.

Advisory Map Page
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When you are on the Advisory Map page, you will see all sites in different alarming states. Advisory Map allows you to have a 
quick glance on your Sites’ status in the past 24 hours. Click Set As Home Page from the user profile icon next to your name.

You can also set other Graphical Screens as your Homepage. As introduced in the What is 
Connect+ session, Graphical Screens are Floor Plans or Summary Screens for real time store 
monitoring. You can access these Graphical Screens from the Navigation Tree, when you 
right-click on any level, you will see a list of System Summary Screens indicated with blue 
icon, and customized graphical screens with an orange icon.

Open any Graphical Screen at any tree level, then click User Profile > Set As Homepage, 
then the Graphical Screen will be set as your Connect+ Homepage.

NOTE: You can also set Homepage for each site, this will be covered when we review more 
details into Graphical Screen Session.

Graphical Screen
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3.5   Manage Your Own List

A list contains points that you are interested in. You have flexibilities to choose your preferred points from different stores, 
controllers for same application type to compare store performance. Or you can also select a number of points for a single store 
or controller to monitor.

You can also create list for yourself via List Power Builder. Access List Power Builder from the link of Watch or Graph Points 
page.

You can create and save a new list in Watch Point Lists page (refer to Section 10   List Power Builder), all the lists will be shown 
in the Load Selection from list drop-down. You can choose one desired list to view the points value.

List Power Builder

Watch or Graph Points

Choose one List
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4.   View Enterprise Summary

If you want to have an overall understanding of your Enterprise Assets such as:

•	 How many stores do I have?

•	 How many controllers do I have?

	» How many are building controllers?

	» How many are Ref Controllers?

	» How many are E2 and how many are Site Supervisor?

•	 How many Case Controllers do I have?

•	 How many Rooftop Units do I have?

The Enterprise Summary in the toolbar menu is the right place for you to find these answers.

You can view the Enterprise Summary from a Directory to Application Instance. Each contains different information.

With the Advisory View, you can sort, filter and add more columns for your review. You can also export to Excel, PDF or HTML 
file types. 

Enterprise Summary
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5.   Advisory Map, Advisory View and Live Advisories

Advisories are defined as the notifications or alarms 
generated from Controllers to report store a crisis. Currently 
Connect+ support receives Advisories directly from 
Copeland Controllers E2, Site Supervisor, and XWEB. 
Connect+ can also receive Advisories from Danfoss if a 
Danfoss Site is sending an alarm to Copeland ProAct Alarm 
Service.

Advisory Type by Controller:

•	 E2: Alarm, Device Failure, Notice

•	 Site Supervisor: Critical, Non-Critical, Notice

•	 XWEB: NA

•	 Danfoss: Severe, Critical, Normal, Log Only

Advisory State:

Each advisory in Connect+ would have two states: Active or 
Return to Normal.

An advisory would remain active until the condition to 
generate the advisory returns to normal.

Active

Advisory occurs when a controller generates the alarm 
based on Alarm parameter configured. Alarm Parameters 
involved in Advisory Occurrence are High/Low limit and 
Alarm Delay.

For example, a technician can configure Case Controller 
Temperature Alarm Hi/Low limits for the normal temperature 
range and a 10-minute Alarm Delay. Once temperature is 
above or below setpoint, even above Hi Limit or below Low 
Limit, the controller will wait until the Alarm Delay passes, 
then generate the alarm.

The alarm will remain Active from the Advisory Occurrence 
Time until the point value returns to normal.

Return to Normal

An advisory will Return to Normal once the point value 
is back inside the normal range. There is another Alarm 
Configuration that will affect Advisory Return to Normal time: 
Alarm Hysteresis. When Alarm hysteresis is configured, the 
advisory will change to state Return to Normal only when 
current point value is in range of  
(Hi Limit – Alarm Hysteresis) and (Low Limit + Alarm 
Hysteresis).

Advisory Priority:

Advisory Priority is a concept with Copeland Controllers. 
Connect+ provides the same concept for these controller 
types:

•	 E2 1-99                                     

•	 E3 and Site Supervisor 1-99

Urgency Level

Urgency Level is a Connect+ defined Advisory Property. 
When you have multiple controllers across an organization, 
it is difficult to tell which advisories need your immediate 
attention with different advisory definitions for different 
controllers.

 In order to solve this problem, Connect+ defined Urgency 
Levels as shown below. This allows users to have a 
consistent view of an advisory’s severity. Currently the 
definition is default in Connect+:

Advisory Priority for E2, E3, Site Supervisor and XWEB

Urgency Priority State
Example Alarm 

Type

High
1 to 20

Active

Room Temp Alarm

Food Safety Case Temp and  
Prod Temp

Medium 21 to 50 Heat Pump  
Status Block Alarm

Low 51 to 99 HRC Alarm from  
Heat Pump

Low 1 to 99 RTN

•	 XWEB 1-99

•	 Danfoss NA

Advisory Priority for Danfoss

Urgency Type State

High Severe or Critical

ActiveMedium Normal

Low Log Only

Low Any RTN
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5.1   Advisory Map

5.1.1   Access problematic stores via Advisory Map

If your organization has enabled Advisory Maps, when you click on the parent directory in the Navigation Tree, you will see 
an Advisory Map as shown below with the Advisory Urgency legends. You can set this page as your Connect+ Homepage for 
Enterprise View.

Sites in the Advisory Map are indicated with Alarm Urgency Level in the past 24 hours.  
You can click on any problematic sites to further investigate based on the below legends:

•	 Red indicates Sites with Food Safety Alarms/High Alarms

•	 Orange indicates sites with medium urgency Alarms

•	 Yellow Indicates sites with low urgency Alarms

•	 Green indicates sites that does not have active Alarms

•	 Gray and flashing indicates s there is no Alarm Connection

Advisory Map

Search Box

If you know your Site Name, you can also enter the site name in the search box. The search result will flash for five (5) seconds 
on the Advisory Map for you to check further details.
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Clicking on the Site, you will see a snapshot of the Site, which includes Site Name, Site Address, and several quick links.

•	 When clicking Site Name, you will be directed to your Site Home Screen if set.

•	 When clicking Advisory View, you will be directed to View Advisories.

•	 When clicking Controller View, you will be logged into the controller’s Terminal Mode.

Advisory Map View allows you to review your stores and locate problem sites as quickly as 
possible. The quick links for each site provides access to locate the advisory information and 
take further actions. From Advisory View, you can review Alarm Details and Log Graph. From 
the controller View, you can access Terminal Mode if you need to change settings to clear the 
alarm. 

Site Snapshot

5.1.2   Your Advisory Map Setting

Advisory Map Setting
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1.	 Map or Satellite View: Allows you to switch Google Map View or satellite view. With satellite view, you can review a real 
time picture of your stores, see roof top units if available, and more.

2.	 Setting: If you have a large number of stores, your Advisory Map may appear full.  
You can filter your stores in the Advisory Map to have focused views.

Once you click OK, your Advisory Map Preference will be saved. When you view the Directory 
Advisory Map again, it will only show the sites with your preferences.

5.2   Advisory View

The enterprise toolbar alarm icon provides a quick overview on how many total active alarms you have across your stores 
in the past 24 hours. Whenever there is new alarm received by Connect+, the number will add and flash for several seconds.

Map or Satellite View

Advisory View Legend
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5.2.1   Advisory List View

You can access the Advisory List View when you click this tool bar. As Advisory Map View, the Advisory List View is organized 
by Advisory Urgency Level. Mouse over the Urgency button to see the definition of each urgency level.

Column Name Description

Occurrence Date Shows the date and time when the advisory was generated on controller

Received Date Shows the date and time when the advisory was received in Connect+

Alarm Age

Shows advisory duration.

•	 If the advisory is still active, Alarm Age = Current Date time – Occurrence Date.

•	 If the advisory is return to normal, Alarm Age = Return to Normal Date – Occurrence Date

RTN Date Shows the date time when the advisory is back to normal.

Source Shows controller, application, and property information from where the advisory was generated.

Source Type Connect+ will also generate advisories in addition to controllers. Such as Controller Offline Alarm, Predictive 
Maintenance Alarm, and more. Source Type indicates if it is from the controller or Connect+ Apps

Point Shows the point from which the advisory was generated.

Limit Shows the high or low limit the advisory will exceeded to generate the advisory. This is usually configured by 
your Technician during commissioning phase on the Controller. 

Trip Value Shows the point value when advisory is generated.

Advisory Message Shows an explanation of the advisory. This is usually configured by your Technician during commissioning 
phase on the Controller

Add Comment Users can enter a comment for the selected advisory

Comment  Shows the latest comment a user entered.

Type

Different controllers using different Type to categorize Alarm Severity.

•	 E2: Alarm, Fail & Notice for E2

•	 Site Supervisor: Critical, Non-critical and Notice

Priorities It shows urgency level of advisories as numerical (1-99). It is configurable in Controller

Advisory List View

Table 4: Advisory List
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5.2.2   Read Alarm Related Log Graph

From Advisory List View, you can access the Advisory Detail Information and login to the controller if needed.

•	 Access Point Log Graph from Advisory Message link

From Advisory View, you can only see alarm-related points log graph. The same applies to log graph in advisory email. You can 
read multiple points Log Graph from Watch Points and Graphical Screens, which will be introduced in a later session.

The information below will help you to read the Log Graph:

Item Description

Log Graph Range Set the time range of the data to show points logged in a graph. 

Alarm Status Shows advisory points and its related points value and alarm status

Point Log Shows advisory point and its related points log in graph.

Defrost Cycle Shows defrost status in graph

Setting You can choose time perspective, download, print, and save log graph date range as default.

5.2.3   Other Quick Links

From Advisory List View, there are other quick links to:

•	 Access Site Home Screen from Site Link

•	 Access Controller Summary Screen from Unit Link

•	 Access Application Summary Screen from Application Type Link

Log Graph

Table 5: Reading the Log Graph
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Filter Advisories by Filed Filter: For example, if you enter “Case Temp” in the Advisory Message field, you will filter all the 
alarms with an advisory message that contains “Case Temp”.

5.2.5   Customized Advisory List View

You can customize your Advisory List View by:

•	 Adding or removing more columns as indicated below.

•	 Dragging the column header to reorganize your field sequence.

•	 Clicking each column header to sort the list.

Your preferences will be saved for future viewing.

5.2.4   Filter Advisory List View

Filter Advisory List by Urgency Level or Occurrence Time:

Filter Advisory List

Filter Advisories

Advisory Manage
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5.2.6   Access Advisory List View from Navigation Tree

Field Name Description

Cleared Date Shows the date time when advisory is cleared on controller.

Status Shows whether the advisory has been Acknowledged, Unacknowledged, or Muted. 

When you select one advisory, you will see the option to view Expanded Info, or connect to Terminal Mode if you have the 
permission. 

You can also access Advisory View from all levels in the Navigation Tree by clicking Right-click Menu > Advisories > View 
Advisories.

This allows you additional flexibility to access advisories at a certain site, controller, device or a known point.

5.3   View and Process Live Advisories

5.3.1   View Live Advisory

If your organization does not enable Advisory Receiving in Connect+, then Live Advisories will be where your advisories can be 
reviewed. Connect+ will access the control system or controller to get Live Advisories on the controller when you click Right-
Click Menu > Advisories > View Live Advisories from Navigation Tree at Control System or Controller Level.

Live Advisories View

Table 6: Live Advisories
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Click on Expanded Info, you will see the Advisory Details:

As an Advisory View, you can sort, filter and add more columns for your review. You can also export to Excel, PDF or HTML file 
types.

5.3.2   Process Live Advisories

When you select one or multiple live advisories, you will see three options to process live advisories as shown below: 
Acknowledge, Reset and Clear for E2 advisories:

Expanded Info or Terminal Mode

Expanded Info

Three Options
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Acknowledge, Reset and Mute for Site Supervisor Advisories:

Acknowledge Advisories

When you acknowledge an Advisory, you prevent it from ever annunciating again in any way until you manually reset or clear 
the Advisory. A condition that causes an Advisory will never automatically return to normal when it is acknowledged. When an 
Advisory is acknowledged, the advisory stays in the controller Advisory Log, but all annunciation of the advisory is suspended 
until the alarm is reset or cleared.

Reset Advisories

When you rest an Advisory, you force the Advisory to a normal condition and the Advisory remains in the Controller Advisory 
Log. Currently Reset-To-Normal Alarms will not be marked as Return-To-Normal in Connect+.

Clear/Mute Advisories

The option to clear an advisory completely removes an advisory from the Controller Advisory Log.

TIPS: ACKNOWLEDGEMENT VS. RESETTING

•	 Reset an alarm if you believe the condition that caused it is fixed, but you wish for a new alarm to occur if the problem happens again.

•	 You MUST Reset an alarm that has been previously acknowledged to re-enable the alarm. Failure to do so will cause the alarm to remain 
in ACK, and the alarm will not be generated again. AN ACKNOWLEDGED ALARM WILL NOT AUTOMATICALLY RESET.

•	 Acknowledge an alarm to silence alarm panel horns or lights, ONLY IF technicians have been notified of the problem and have been 
dispatched. Technicians, after fixing the problem, MUST Reset or Clear the alarm to  re-enable alarming.

Acknowledge, Reset and Mute



23026-1020 R3 Connect+ User Guide ©2024 Copeland LP.

6.   Advisory Notification

Advisories can be forwarded to an e-mail address. Open 
the Forward Advisories page by clicking Advisories > 
Forward Advisories from any tree level right-click menu, or 
from Top Menu > Activities > Forward Advisories.

Click the Add New button to set up forwarding to a new address, or to edit an existing address, click on the Address in the box 
(if one is present, it will be visible) and it will take you to the page below:

Forward Advisory Page
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Give the advisory forward a unique identifier in the Name 
field. Because multiple forwarding instances or profiles can 
be set up, you can distinguish them and indicate a purpose/
description for each one.

Description is an optional field for indicating what the 
advisory forward is for (its purpose). For example, “Notify all 
west coast supervisors of compressor failures.”

Advisory Match Criteria

You can choose what kind of Advisory Criteria you want to 
use to send email. 

•	 By Advisory Type – Advisory Type will be shown in Advisory 
Match Criteria after choosing. 

Advisory Priority for E2, E3, Site Supervisor and XWEB

Severity Priority State Example Alarm Type

High
1 to 20

Active

Room Temp Alarm

Food Safety Case Temp and  
Prod Temp

Medium 21 to 
50

Heat Pump  
Status Block Alarm

Low 51 to 
99

HRC Alarm from  
Heat Pump

Low 1 to 99 RTN

Advisory Priority for Danfoss

Severity Type State

High Severe or Critical

ActiveMedium Normal

Low Log Only

Low Any RTN

Advisory Type

Advisory Type is the advisory severity identified on the 
controller. Advisory grade from high severity to low is Fail 
(E2 and XWEB) or Critical (Site Supervisor and E3) or 
Severe (Danfoss), Alarm (E2 and XWEB) or Non-critical 
(Site Supervisor and E3), Notice (E2, XWEB and Site 
Supervisor and E3). 

•	 By Advisory Severity – Once it is be chosen, Advisory 
Severity will be shown in Advisory Match Criteria. You can 
choose Food Safety, High, Medium, Low for advisories filter.

Advisory Severity

Advisory Severity:

Advisory Severity is a Connect+ defined Advisory Property. 
When you have multiple controllers across the organization, 
it is difficult to tell which Advisory needs your immediate 
attention with different Advisory definitions for different 
controllers. 

 In order to solve this problem, Connect+ defines the 
Advisory Severity as shown below. This allows users to have 
a consistent view of an advisory’s Severity. Currently the 
definition is defaulted as the following in Connect+: 

Advisory State indicates two kinds of advisories, Return to 
Normal and Repeat Advisories. Advisories that have been 
returned to normal or duplicate advisories (one advisory 
generates more than once) should keep being sent, you 
can click the check boxes to send them. 

Source Type by Protocol allows different protocol 
advisories to be sent

CB Maintenance, Demand Response, Proact Energy, 
Refrigerant Tracking are different functionally from 
Connect+. System is controller off-line alarm.
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Source Type by Service allows advisories for Connect+ 
supported service to be sent.

Advisories can be sent based on the Advisory Match Criteria 
configuration. If you want to receive high severity alarm for 
E2 and Site Supervisor and E3. Then you can check High 
from Advisory Severity and E2 and Site Supervisor and E3 
from Source Type by protocol.

If you want to send all active and return to normal advisories, 
simply click the Return To Normal check box, and leave the 
Advisory Severity check boxes as unchecked. 

Advisory Match Criteria

Email Format:

Language can let you choose English or Spanish

Time Perspective of the advisory can be set to Site Time, 
My Time (your current browser time zone), or the Server 
Time.

E-mail Format can be set up as Html, Text, or Cell Phone 
(messages sent to cell phones for each individual alarm will 
be abbreviated to conserve space).

Group Advisories by field can let you choose how many 
advisories will be sent in one email. You can choose One 
Advisory per Email or Multiple Advisories per Email.

Connect+ support two kinds of alarm email formats. If you 
want to change the email format, ask the Administrator to 
change it in superuser property.

Email Format

The default format like below:

Alarm Details

Administrator can change 
alarmEmailReportClassicFormat to True for table email 
format below:

Advisory Forwarding
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Email Recipients:

Email Groups can list the groups that you already configured in Email Group Manager. If you want to add a new group or edit 
the existing groups, click Manage Email Group List.

Users field lists all the users with their email address. NO EMAIL will be marked for users who did not configure an email 
address. If you choose a user without an email address, you will receive a message that does not affect the user. 

Additional Emails Addresses field allows you to input additional email address.

Check the directories and sites hierarchy that are applicable to the advisories being sent. If accessing this page directly from 
the navigation tree, the hierarchy will automatically be visible and checked.

After all the configurations are done, click the Save button. The new added forward advisory rule will be listed in the Forward 
Advisories table.

Forward Advisories

Any alarms that match the forwarding rule will be sent out to configured recipients.
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7.   View Sites Not Sending Alarms

You have seen many sites that are not sending alarms from the Advisory Map. Those sites are grayed out and flashing to bring 
attention to them. It will also show up as “Controller Not Sending Alarms since last received time.” in Advisory Message 
column of Advisory View page. 

Controller Offline Alarm

7.1   Controller Offline Alarm

Controller offline alarm is a kind of alarm which can monitor site communication status. It is defined as alarms if site cannot 
receive test connections from controller.

This alarm is generated by Connect+ but not controller. Therefore, you will not see this kind of alarm on controller. It will return 
to normal when Connect+ receives advisories before next test connection time or the next test connection is successful.

Column Name Description

Occurrence Date Shows the date time of last test connection time.

Received Date

Shows the date time when advisory is received. The alarm will be received when system job 
CheckConnectionTestJob run. It is configurable. (Generally, at 12:00AM every day).
If alarm is not solved in 24 hours, Received Date will be updated to latest missed connection date 
time.

Alarm Age
Shows advisory activity duration. 
If advisory is still active, Alarm Age = Current Date time – Occurrence Date.
If advisory is return to normal, Alarm Age = Return to Normal Date – Occurrence Date.

RTN Date
Shows the date time when advisory is back to normal. 
It is latest test connection successful date time or alarm received time.

Advisory Message Controller Not Sending Alarms since last received time

Urgency High

Type Fail

Source Type System

Priority 10

Comment Controller was last commissioned at Controller Last Commission Time

Table 7: Controller Offline Alarm
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7.2   Site not Sending Alarms

If you want to know how many sites are not sending alarms and more information, you can click on Sites not Sending Alarms 
icon on the enterprise toolbar.

You will see a list of sites that are not sending alarms in the Connection Verification Report. If you receive a controller offline 
alarm, you will also see the site is shown as a problem site in Connection Verification Report.

Field Name Description

Test Connections per Day Shows the number of connection tests that occurred in the controller in the last 24 hours.

Number of Missed Connections Shows the number of connection test missed in the controller in the last 24 hours.

Last Received Time Shows the date and time when latest connection test or alarm was received.

Next Received Time Shows the date and time when the next test connection will happen.

Commissioned Date

Shows the date and time when you configured to send advisory configuration information such 
as connection test time and advisory filter priorities for alarms, failures, and notices for E2 and 
Site Supervisor. And shows the first refresh unit date time as commissioned Date for XWEB and 
Danfoss.

Site Not Sending Alarms Legend

Connection Verification Report

Table 8: Connection Verification Report 
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You can click on the link of Last Received Time to view the recent 30 connection information.

You can see two kinds of alarm from Status column in Connection Verification History.

•	 If daily connection test alarm is received, you will see the message:

•	 If advisory is received, you will see the message:

As in the Advisory View, you can sort, filter and add more columns for your review. You can also export to Excel, PDF or HTML 
file types.

Connection Verification History
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8.   Monitor Site from Graphical Screens

8.1   Graphical Screen

As introduced in the What is Connect+ session, Graphical 
Screens are Floor Plans or Summary Screens for real time 
store monitoring. The customized floor plan that can be 
drawn according to user requirements. It can show all 
points on a single page with real-time value for multiple 
entities within the store for your quick view.

Show GS Screen Edit Tool from user profile. The default 
Show GS Screen Edit Tool is disabled. You should click the 
check box to enable it.

Connection Verification History

You can access these Graphical Screens from the Navigation Tree, when you right-click on any level, you will see a list of 
system screens indicated with a blue icon, and customized screens with an orange icon.

•	 System Screens are provided by Connect+ with predefined summaries at site, controller, application type 
and application level.

•	 Customized Screens can be developed by your Administrator or Copeland to facilitate your customized 
needs to monitor or compare store performance.

8.2   System Summary Screen

Tree Level Name Description

Site

Refrigeration Summary Include critical points from Suction Group, Condenser, and Case Controllers

Building Summary Include critical points from Outside/Inside Temp and Humidity, AHU Temp and Status, 
Lighting Status and Schedules

Other Summary Include critical points from Anti-Sweat, Demand Control, Power Channel, Analog Sensor, 
and Digital Sensor

Unit Controller Summary

Sites that usually have multiple controllers:

•	 Building Controller Summary is a subset of Site Building Summary for that specific 
controller.

•	 Ref Controller Summary is a subset of Site REF Summary for that specific controller.

App Type
Summary

Include critical points for the below Application Types: Circuits and other Case Controllers, 
Condenser, Suction Group, Physical AI/DI/DO, Sensor Control AV/DV, HVAC Zone, Lighting 
Control, Power Monitoring, Anti-Sweat, Analog Combiner, Digital Combiner, Flexible 
Combiner, and more.

Defrost Summary Only applies to Case Controller Application Types

Table 9: System Summary Screen
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Tree Level Name Description

App Ins

Status
Include critical input, setpoint and output points properties for application instance. Only 
Application Instance from an Application Type that has Summary Screen will have Status 
Screen. (See App Type > Summary)

Graphical Summary Can be found in Application Instances from AHU, Condenser, Circuits, Suction Group, 
Sensor AV/DV for graphical presentation of the physical device.

How to Read Summary Screens

Each Summary comprise several tables. Table header is defined as:

As you can see from the example below, each table header has Unit as fixed header, with different Application Types such as 
Enhanced Suction Group, Condenser, Circuit (CC) and Circuit (Standard). For each Application Type, point is also different.

Read Summary Screens

Table 9: System Summary Screen
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8.3   View Customized Screens

Your organization Admin, Service Provider, or Copeland Project Team might have developed customized screens to match 
your requirements. Connect+ Graphical Screen Tools provide different image libraries and widgets to allow vivid visual 
presentations of your store to be created.

You can view store floor plans as indicated below, or pull data from several stores to compare Food Safety Setpoints. Talk 
to your Admin, Service Provider, or Copeland Project Team about what is right for you. You can set customized screens as a 
Homepage or Site Homepage for quicker access.

Customized Screen
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8.4   Quick Create GS Screen

After selecting the Add GS Screen, you will see the GS 
Screen toolbar. Click the Add Widgets Palette to create 
your own GS screen.

Widget Palette

Select the desired widget.

Selecting Desired Widgets

Right-click on the widget for editing capabilities and 
properties, you can select Properties to open the Editor.

Properties

Add any desired points by selecting the point check boxes in the navigation tree. After you select the points from navigation 
tree, the points will automatically show under Point Reference on the Properties page. That means the point is associate to 
the widget. The widget will show associated points and value.

Point Reference
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8.5   Save GS Screen

After the GS screen is completed, you can click the Save 
icon to save your own GS screen. A Save GS Screen 
window opens and will ask you to name your GS Screen.

Enter a name for the GS Screen and click OK. Your GS 
Screen will be saved. You can check the new GS screen 
from the tree node menu (right click on the tree node).

Once you have saved the GS Screen, the save icon will be 
gray and cannot be selected.

After creating a GS Screen, toggle the Edit button to  
Run mode to see the GS Screen become active and show   
real-time values.

Save GS Screen

Screen Widget

8.6   Run/Edit GS Screen

Edit Mode: If you are adding or creating a GS Screen, you 
are automatically in Edit mode when you first arrive at this 
page. The Run button indicates that you are in Edit mode. In 
this mode, you can edit the GS Screen.

Run Mode: After a GS Screen has been created and you 
arrive at a saved GS Screen, you are automatically in Run 
mode. Run mode shows the GS Screen operating in  
real-time. You can see the Edit button shows in the menu.

Toggle this button to go back and forth between modes.

Edit GS Screen

Run GS Screen

8.7   Delete GS Screen

If you want to delete a GS Screen, you can click the  
Run/Edit toolbar to edit the GS Screen. Click the Delete 
icon to remove the GS Screen.

Deleting GS Screen

GS Screen Properties

8.8   Property of GS

In GS Screen Edit mode, this GS Screens properties 
menu is located on the GS Screens tool bar. Selecting 
the Properties icon will open the GS Screen Properties 
window and display all properties that belong to the GS 
Screen currently being viewed.

GS Screen for Properties
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GS Screen Copy and Pasting

Click the Copy menu and a copy completed message 
appears, which you can paste on another same-level tree 
node

Copy Competed Message

Properties:

•	 The Name given to the GS Screen is displayed.

•	 Menu Display Name is how the GS Screen name will appear when displayed on the menu.

•	 Description is a brief description of the GS Screen.

•	 External URL is the GS Screen URL that can be used for referencing the GS Screen location externally.

	» Multi-Association Expr is the Javascript expression that is evaluated by the tree in order to create a rule for associating a screen to 
multiple tree nodes or location.

	» Background Color: Specify a color value to set the background color of the screen, defined like any other CSS color is defined (for 
example, blue, green, red, or #fabc09 can be entered). 

•	 Border: Specify this property to add a border around the GS Screen. For example, entering “5px solid blue” would create a 5-pixel solid 
blue border (CSS style). 

•	 With Auto Scaling enabled, the GS Screen automatically scales up to fit the size of the window.

•	 When this Published check box is checked, the GS Screen will be made public

•	 Author: Read-only field that shows the author of the GS Screen (the originator of the screen or who imported it).

•	 Date Created/Last Saved: Read-only field that shows the date/time the GS Screen was created or last imported.

•	 Site Directories Version: Read-only field that shows the current Connect+ software version.

•	 GS Screen Schema: It indicates the version number of the GS Schema. This number changes whenever structural changes to the screen 
design changes.

8.9   Copy/Paste GS Screen

If you want to create one Graphical Screen and use the 
similar screen on another same-level tree node but with 
different point mapping, you can use Copy/Paste GS Screen 
function.

Copy/Paste can only be used on a customized Graphical 
Screen.

In GS Screen Edit mode, you can see the Copy menu is 
located on the GS Screens tool bar.

You can right-click the tree node of the same level and select Views > Paste GS Screen. A mapping table will appear and allow 
you to choose the correct mapping instance.

Mapping Table
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Source Application Instance: The path of the application instance that is associated in the copied Graphical Screen.

Target Application Instance: The path of the application instance that will be associated to the copied Graphical Screen. The 
instance whose type is same as the Source Application Instance will be listed in the Target Application Instance drop-down. 
Choose the desired Instance for mapping.

If the target Application Instance name is same as the source Application Instance name, it will be pre-filled. You can change 
the Instance by selecting another one from the drop-down list. But if there is no corresponding Application Instance of the 
Target Application Instance, a No corresponding Instance found message will appear.

After the mapping configuration is done, click the Paste button. The copied GS Screen will be displayed.

Graphical Screen

After pasting the GA Screen, widgets with exclamation 
marks may appear. This indicates the point associated to 
the widget cannot be found for the pasted tree node. 

Right- click on the widget, and select Properties to remove 
the existing points and re-map them, or use Duplicate and 
Rebase to replace the point.

Duplicate and Rebase

Duplicate and Rebase:

Right- click on the widget, and select Duplicate and 
Rebase.

You will see a duplicate widget and at the same time the 
tree background will be highlighted yellow.

Tree Background
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Clicking one desired application instance whose 
application type is same as the original one will cause the 
background to disappear.

Go to the Properties of the widget, to see points are 
automatically synced to the selected Instances.

For the pasted GS screen name, you can see it displayed as 
Copied GS Screen name-tree node name

(copied from old tree node name) from the right-click 
menu of the tree node.

Tree Node

If you want to change the GS screen name, you can click 
Properties menu from GS Screen tool bar.

Changing GS Name

And provide a Menu Display Name.

Providing Menu Display Name

Click OK from the Properties page and click Save the  
GS Screen.

You will see the menu is updated from the tree node.

Updated Tree Node

Saving GS Screen

8.10   Export GS Screen

You can export a GS screen and send the floor plan to 
another user for viewing. All GS Screens that are exported 
will be saved in .ZIP format. 

To export the GS Screen, click the export icon in Edit mode.

After exporting the GS screen, you will see a zip file with the 
GS screen name that has been downloaded.

This exported GS file can be imported to Site Supervisor/E3 
as the floor plan.

Export GS Screen
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8.10.1   Installing Custom Screens in Site Supervisor
1.	 Log in to the Supervisor using a One-Day Password. Please send an e-mail to ColdChain.TechnicalServices@Copeland.com 

for the password.

2.	 After logging in, click the Floorplan icon.

3.	 Then click Go to install.

Floor Plan Icon

Go to Install

mailto:ColdChain.TechnicalServices%40Copeland.com?subject=
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4.	 Click Install Floorplan button.

5.	 A window will pop out where users will have the option of getting the custom screen file from the local PC or the 
controller’s SD memory card. For this example, click Local PC or other devices.

Install Floorplan Button

Install Floorplan Window
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6.	 Another window will pop out. This time, navigate to the location of the custom screen file. Highlight the file and click the 
Open button.

7.	 Click the Install button.

Open Button

Install Button
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8.	 Wait while the floorplan is being installed. Once completed, you may click the Ok button.

9.	 To access the screen, click the Floorplan button on the Main Menu.

Floorplan on Main Menu

OK Button
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10.	 The screen will then be shown.

11.	 Going back to the Home Page, click on the Gear icon.

Screen

Gear Icon
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12.	 Select My Profile on the drop-down menu.

13.	 On my profile, click on selection beside Set Home As then chose Floorplan on the drop-down menu.

My Profile

Choose Floorplan
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14.	 Check if the Custom Screen name is automatically filled in on the Home Screen. If not, click on the selection and chose the 
screen.

15.	 Click on the Save button to finish.

Custom Screen

Save Button
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8.11   Import GS Screen

Importing a GS screen allows you to view and work with a 
GS screen (that another user may have sent to you) before it 
is published in the system for all users to see. It will be visible 
in your Navigation Tree view, but not to other users. 

You can import the GS Screen from its associated place on 
the navigation tree or toolbar manual.

Import GS Screen

Choose a file that you want to import and click the Import 
button.

Choose a file to Import

After importing is complete, the new GS screen will be listed 
on the context menu for that node in the navigation tree.

Navigation Tree

8.12   Associate GS Screen

GS Screens can be associated with more than one node or 
position on the navigation tree. To associate a GS Screen 
to a particular node or position on the navigation tree, click 
Associate GS Screen from the navigation tree menu or the 
toolbar menu.

Associate GS Screen

The list is restricted to display only the appropriate level GS 
Screens. Only the GS Screens that have been published 
or GS Screens that were created by logged-in users are 
included in the list. If no screens are listed, no screens have 
been created for the selected navigation tree-level node. 
Once a screen has been associated to a specific node on 
the tree, it will be removed from the list for that node.

Select one GS Screen from the table to associate. After the 
selection is complete, click the Associate button.

Associate Button

When associating is done, the selected GS Screen can be 
associated to the tree.

Associating GS Screen to the Tree
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8.13   Disassociate the GS Screen

You can disassociate a GS Screen from the node on the 
navigation tree it is associated with. Open the GS Screen 
you would like to disassociate with its current node. Make 
sure you are in Edit mode and click Disassociate from GS 
Screen menu.

Disassociating from the GS Screen Menu

You will see a message to confirm if you wish to disassociate 
the GS Screen.

Disassociate the GS Screen

Click the Disassociate button. The GS Screen will be 
disassociated from the current node and can then be 
associated with another node somewhere else on the tree. 

8.14   Print GS Screen

While viewing a GS Screen, you will see a Print icon at the 
topmost right corner of the screen.

Print Icon

Click the icon to export GS Screen a PDF. 

8.15   Widgets

8.15.1   Widget Properties

The widget context menu allows you to change the layer 
positioning of the widget on the GS Screen, duplicate 
(create additional copies of the widget on the page), 
delete the widget, or go to the Image Properties editor of 
the widget, which gives you further configuration options. 
Right-click on a widget in Edit mode to show the widget 
context menu.

Widget Content Menu

You can change the settings of each widget with these 
actions:

•	 Bring to Front: Positions the widget to the top, in front of all 
other widgets.

•	 Send to Back: Positions the widget behind all other widgets.

•	 Bring Forward: Positions the widget one layer down.

•	 Send Backward: Positions the widget one layer up.

•	 Duplicate: Creates a copy of the widget along with its 
properties.

•	 Delete: Removes the widget from the screen. Selected widgets 
and grouped widgets can also be deleted by pressing the 
Delete or Del keys on your keyboard.

•	 Lock Size/Position: Saves and holds the most recently set 
size and position of the widget so it is locked out of clicking, 
dragging, and other changes. The widget selection handles 
will turn purple to indicate the widget is locked. When the 
widget is in lock mode, this menu option will read Unlock Size/
Position. Click Unlock to release the widget. 

•	 Properties: Displays the widget Property menu for more 
configuration options for each widget. The Properties menu 
options for widgets will vary depending on which type of 
widget you choose.

•	 Reset Scale: Click this option to return to the previously 
configured widget size.

•	 Convert to Sub-Screen (if available): Zone widgets allow 
you to create a new GS screen based on a portion of another 
screen.

•	 Duplicate and Rebase (if available): Click this option to 
duplicate the widget. Just as the Duplicate option, but 
additionally the widget will enter a special mode where you 
can select a different Application Instance (or any node except 
a point node) to use as a new base for all the references in the 
widget.
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Any previously selected widgets will be unselected and 
the new duplicated widget will be selected (the Duplicate 
action by itself will not do this) and the screen editor and 
main tree will go into a special mode where you must now 
select a new node from the main tree to use as a base for all 
the references in the widget(s). The tree background will be 
highlighted yellow, and a pop up bubble will display with 
instructions and a Cancel link to exit this mode. Canceling 
will not remove the duplicated widget but will cause the 
widget to have the same references based on where they 
were in the widget from which it was duplicated from.

The tree will automatically synchronize to the application 
instance of the first reference of the widget being duplicated 
when first entering this mode (because in most cases the 
designer would probably want to select the next application 
instance in sequence after it.) You may continue to edit 
widgets in any way while in this special mode, and even 
select other widgets. Once clicking on a node in the tree, 
all selected widgets will be “rebased” to that node. Group 
widgets that are selected will also have all their sub-widgets 
rebased in this way. Undo by pressing Ctrl+Z just like any 
other editing action can be undone.

8.15.2   More Widget Editing
•	 Selecting Multiple Widgets: Multiple widgets can be selected 

by using the mouse to click and drag to enclose widgets within 
a selection rectangle, or by pressing the Shift key while clicking 
desired widgets. After you have selected multiple widgets, they 
can be grouped using the right-click menu option.

•	 Deselecting: To deselect widgets, click the area outside the 
widget(s).

•	 Resizing/Scaling: All widget types can be resized by clicking 
on the widget and using the red selection handles that appear 
on the edges. Drag the edges to resize and the entire image 
will scale. Note that real-time indication of x, y position is shown 
automatically when moving widgets. (Reminder: Click Reset 
Scale return to the last saved widget size.)

•	 Alignment: Before grouping widgets, you can fine-tune the 
widgets’ placement right by selecting Align Selected on 
the widget’s right-click menu. Widgets move in one-pixel 
increments.

Widget Menu

	» Left: Aligns selected widgets to the left.

	» Right: Aligns selected widgets to the right.

	» Top: Aligns the top of the widgets equal (flush) with each 
other.

	» Bottom: Aligns the bottom of the widgets equal (flush) with 
each other.

	» Horiz. Center: Centers the widgets equally horizontal 
depending on the starting position of the widgets. For 
example, if the widgets are vertical to each other to begin, 
one will be placed on top of the other, hiding the widget. To 
undo, click the area outside of the widgets.

	» Vert. Center: Stacks the widgets equally vertical (one 
above the other) depending on the starting position of 
the widgets. For example, if enough space separates the 
widgets to begin, they will be stacked one directly above 
the other. Widgets will overlap if there is a negligible 
amount of space separating them before vertically 
centering occurs. To undo, click the area outside of the 
widgets.

•	 Grouping: After selecting the widgets to be grouped, click the 
Group Selected option on the widget right-click menu. The 
selected widgets are now grouped together and will allow 
you to move them as a whole. Red boxes will appear around 
the grouped widgets as a whole and disappear from around 
individual widgets. To undo, choose from two options that 
appear on the widget right-click menu:

	» Ungroup This: Ungroups a single widget with-in the 
group. Place the cursor on the widget you wish to ungroup 
and select Ungroup This. To finish separating, click off 
the widget and then reselect it to move. Red boxes will 
reappear at the corners of the widget to indicate it has been 
ungrouped.

	» Ungroup Group: Ungroups all widgets within a group. Red 
boxes will reappear at the corners of individual widgets.

•	 Duplicating: Right-click the widget you wish to duplicate and 
select Duplicate from the menu. Finish by clicking outside the 
newly created widget to deselect from the first widget. If this 
option is chosen on grouped widgets, the entire group will be 
duplicated.

•	 Deleting: After multiple widgets have been selected (two or 
more), they can be deleted by clicking Delete Selected. This 
will remove all selected widgets from the screen.
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8.15.3   Image Library

For some widgets, it allows you to upload your image for 
your system. For example, GsImage, GsImageCircuitStatus, 
GsImageOnOff, etc.

You can right- click the widget and select Properties.

Image Uploading

You will see an Images section: click the Browse button to 
open the Image database\library to begin using images by 
the user.

Image Section

There are two types of images in the database: preset 
system images and user images the user imports by right-
clicking the User folder. All are listed in alphabetical order. 
User images are images created, modified, and/or uploaded 
by the user and may also be deleted from the database.

User Images Database

User images can be found in folders created by users, or 
in the User folder. System images may not be changed or 
deleted from the database because they are preset in the 
system.

To add your own image, right-click on User and select  
Add to, choose an image from your computer.

Adding Image

The image will be displayed at the bottom of the menu.

Image is displayed on Bottom Menu
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Click Upload and you will see the image is added to the 
User folder.

Uploading Image to the User Folder

Use the image database\library to add images to your 
widgets. Choose images from System and User directories 
on the Navigation side and create your own directories to 
store the user images you create. Use and edit images from 
the image database by selecting the image from the tree 
and clicking Use This Image.

Use this Image Menu

Each widget has its own unique functionality depending on 
how you want the widget to behave and what points the  
GS Screen will be connected to. For example, ON/OFF 
states, defrost overrides, values (text widgets), analog and 
digital states.

8.15.4     Point References for Image Circuit 
Status and Zone Circuit Status 
Widgets

Point Reference in Menu

For both GSImageCircuitStatus and GsZoneCircuitStatus 
widgets, only the Alarm Out and Defrost points can be 
associated with these two widgets in this order:

1.	 1st point reference is ALARM OUT

2.	 2nd point reference is DEFROST

Alarm Out/ Defrost

The GSImageCircuitStatus and GsZoneCircuitStatus 
widgets have color indicators that will change based 
on the point being in alarm or defrost. For example, 
GsZoneCircuitStatus can be used to cover a zone or area 
on the floor plan. The colors will change depending on the 
information received from the controller regarding alarm 
and defrost states. Upload and use any image to show the 
state of the point.

The GsImageCircuitStatus and GsZoneCircuitStatus 
widgets have a default Link of Standard Circuits 
Graphical Status and a default Link Path of  
${0.appInstPath}.

This means when GsImageCircuitStatus and 
GsZoneCircuitStatus widget types are newly added, when 
clicked, they will go to the Standard Circuits graphical status 
screen for the application on the first point reference on the 
widget by default.

8.15.5   GsText and GsTable Widgets

GsTable:
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GsText:

Property Description

Text Alignment Center, Left, Right

Font Size 9px, 10px, 12px

Font Family Times, Courier, Arial

Font Variant Normal, Small Caps

Font Style Italic, Normal, Oblique

Font Weight Normal, Bold, Bolder, Lighter, or enter a numeric value from 100 -900 (normal = 100, bold = 700)

Header Color Enter a color value in this field: blue, green, etc.

Header Background Color Enter a color value in this field to set the color of the background header: Blue, Green, d0d0d0, etc.

Header Boarder Enter a pixel size and color value in this field to specify the header border attributes,  
for example: 2px solid blue

Header Inside Boarder Enter a pixel size and color value in this field to specify the header inside border attributes,  
for example: 1px solid black

Row Header Specify the values to appear in the row header separated by commas, for example:  
Unit, Application, Point, Type, Value

For text and table widgets, some of the text features you will see on screen are listed in the Property column. The options you 
can enter manually are listed in the Description column.

The GS Table widget has a Column Widths feature so that the width of each column can be set manually. This list is a  
comma-separated list of pixel widths for each column. Each column can have its visibility controlled if the header item for that 
column has a reference to a point reference and that point reference is not visible.
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8.15.6   GsAppSummaryTable Widget

The Summary Screen widget GsAppSummaryTable will be available on the GS Screen at the control system, unit, and 
application type levels on the tree. It will not appear on the widget menu for screens at directory, site, and application instance 
levels.

Click GsAppSummaryTable on the Add Widget palette to add this widget to your GS screen. 

GsAppSummaryTable can list all the same points of one unit’s same application types in the table. Points to be associated with 
this widget can be pre-selected before selecting the widget.

For example, when you select CASE TEMP1 and CASE TEMP STPT from one Circuits (Standard), after clicking 
GsAppSummaryTable, you will see all Circuits (Standard) instances listed in the table with CASE TEMP1 and CASE TEMP STPT 
points.

Editing Widgets Property

To edit the widget’s properties, right-click the widget and 
click Properties.

The Application Type is auto selected for the widget.There 
is only one valid application type if the GS screen is at that 
level of the tree.

Application rows will be generated for all corresponding 
application types found for the specified application type 
where the GS screen is located. This can span multiple units 
if the GS screen is at control system level.

Note that the widget will not show any application rows until 
an Application Type is selected from the Properties page.

GsAppSummary Table

GsAppSummaryTable Widget
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8.15.7   GsBarGraph

The GsBarGraph widget uses bars as a representation of 
point reference status. Each colored bar on the graph along 
the X-axis represents a point reference and the height of the 
bars corresponds to the point value on the Y-axis. High and 
low limits are indicated by the lines across the graph.

GsBarGraph Widget

Click GsBarGraph on the Add Widget palette to add this 
widget to your GS screen. To edit the widget’s properties, 
right-click the Widget and click Properties.

GsBarGraph

Property Description

Label The name or description that will appear on the widget. The default setting is Graph.

Show Label Location on the widget where the label will be displayed.

Show Value Select whether to display the actual values or not, and lets you select where to display values on the 
widget.

Bar Width Width of the bars in pixels. The default value is Auto, which means the bar width will adjust 
automatically based on the number of bars displayed.

Minimum Value The lowest number that the Y-axis can display if it cannot be determined automatically from setpoint 
values.

Maximum Value The highest number that the Y-axis can display if it cannot be determined automatically from setpoint 
values.

Line Color for Low Limit The line color of the low limit across the graph from left to right. Default color is blue.

Line Color for High Limit The line color of the high limit across the graph from left to right. Default color is red.

Reference for Low Limit Low limit reference point on the Y-axis.

Reference for High Limit High limit reference point on the Y-axis.

Use the legend on the right-hand side of the graph to reference the points associated with each bar.

GsMeter Widget

Click GsMeter from the Add Widgets palette to add the 
widget to your GS Screen. Right-click the Widget and click 
Properties to change the widget’s properties (for example, 
image dimensions, gauge color, scale values, and more). 

Note that if the widget is associated with more than 
one point in the navigation tree, only the primary point 
reference value will be displayed.

GsMeter

8.15.8   GSMeter

The GsMeter is a vertical scale widget that can display a 
point value (usually a temperature or pressure reading) by 
referencing or associating the widget with a point in the 
navigation tree. The gauge indicator moves up or down as 
the value of the point being referenced changes in real time.
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Property Description

Gauge Color The color of the gauge indicator. The default color is red. To change the color, enter the name of the 
color into the field.

Gauge Thickness The thickness of the indicator in pixels.

Minimum Value The lowest possible value that the scale can display (at what number the scale starts).

Maximum Value The highest possible value that the scale can display (at what number the scale ends).

Show Indicator Enable the check-box to show the actual point value on the indicator or disable to hide the value.

Temperature Label Ticks The number of tick marks between to major tick mark labels on the meter.

Temperature Label Origin With what value the scale starts to show the number.

Major Hash Mark Ticks The number of ticks a mark stands for.

Hash Mark Tick Interval The number of units a tick stands for.

8.15. 9   GSDial

Similar to the GsMeter, the GsDial widget displays real-time 
point value by associating the widget or referencing it to 
a point in the navigation tree. This widget has a pointer 
(indicator) that moves and points to a value in the scale 
depending on the current value of the widget’s point 
reference.

GsDial Widget

To add this widget to a GS Screen, click GsDial on the  
Add Widgets palette. To modify the widget’s properties, 
right-click the Widget and click Properties.

GsDial

Property Description

Type The kind of GsDial to use (Dial or Meter).

Hand Color The color of the gauge indicator or hand. The default color is blue. To change the color, enter 
the name of the color into the field.

Hand Thickness The thickness of the indicator in pixels.

Label The name or description that will be displayed for the widget. This defaults to ${0.name}, 
which is the name of the point as it appears in the Navigation tree or context menu title.

Show Label Location of the widget where the label will be displayed.

Minimum Value The lowest possible value that the scale can display (at what number the scale starts).

Maximum Value The highest possible value that the scale can display (at what number the scale ends).

Label Ticks The number of tick marks between two major tick-mark label on the dial.

Label Origin With what value the scale starts to show the number.

Major Hash Mark Ticks The number of ticks each mark stands for.
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Property Description

Hash Mark Tick Interval The number of units a tick stands for.

Gauge Configuration Enable Enable the check-box to enable additional gauge configuration.

Low Limit Value Ceiling/Upper limit value for the low limit range.

High Limit Value Starting/Lower limit value for the high limit range.

Low Limit Status Color Color that represents the low limit range.

Normal Status Color Color that represents the normal value range.

High Limit Status Color Color that represents the high limit range.

8.15.10   GSPercentageBar

GsPercentageBar Widget

The GsPercentBar widget displays point reference value in percentage. 

To add this widget to a GS Screen, click GsPercentBar on the Add Widget palette. To edit the widget’s properties, right-click 
the Widget and click Properties. 

Note that if the widget is associated with more than one point in the navigation tree, only the primary point reference value 
will be displayed.

Property Description

Label The name or description that will be displayed for the widget. This defaults to ${0.name}, which is the 
name of the point as it appears in the Navigation tree or context menu title.

Show Label Location on the widget where the label will be displayed (Top, Bottom, Left, or Right).

Show Value Allows you to select whether to display the actual value of the point reference and measurement.  
Unit or not, and lets you select where to display the value on the widget.

Bar Fill Color The color of the percentage bar. The default color is blue. To change the color, enter the name of the 
color into the field.

Show Percentage Enable the check-box to show the percentage number value.

Show Low/High Value Enable the check-box to show the low and high values at the bottom of the widget.

Low Value The low reference point value.

High Value The high reference point value.
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8.15.11   GsPushButton

GsPushButton Widget

To jump to another GS Screen, you can use GsPushButton. 
To add this widget to a GS Screen, click GsPushButton 
on the Add Widget palette. To edit the widget’s properties, 
right-click the Widget and click Properties.

GsPushButton

Property Description

Label Text The label name will be displayed on the 
button.

Text Alignment Center, Left, Right

Font Size 9px, 10px, 12px

Font Family Times, Courier, Arial

Font Variant Normal, Small caps

Font Style Italic, Normal, Oblique

Font Weight
Normal, Bold, Bolder, Lighter, or enter a 
numeric value from 100 -900  
(normal = 100, bold = 700)

8.15.12   GsPushButtonOverride

GSPushButtonOverride widget type provides a constant 
override or will cancel the override on the referenced point.

To add this widget to a GS Screen, click 
GSPushButtonOverride on the Add Widget palette. To 
edit the widget’s properties, right-click the Widget and click 
Properties.

GsPushButtonOverride

GsPushButtonOverride Widget

When the GS screen is created, properties will be 
configured for the point to be used for the override, as well 
as the value being overridden to, and also the length of time 
to override. The images can be changed to “On” and “Off.” 
At screen runtime, selecting the image or button will initiate 
an override of the selected point all the way to the controller. 
Note also that the status of the override widget will change 
when the state is read from the controller.

Property Description

Type
Could be Timed or Fixed for E2 points 
and only support Timed for Site 
Supervisor and E3 points.

Time The field will be displayed once the type 
is selected as Timed.

Value The override value.

Label Text The label will show on the button.

Note
Indicates the label can only support 
300 bytes. This information cannot be 
updated.
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8.15.13   GsSlider

View and change the setpoint setting of a point reference 
using the GsSlider widget. The GsSlider widget has a 
slider control/bar that can be moved up and down to adjust 
setpoint.

GsSlider Widget

To add this widget to a GS Screen, click GsSlider on the 
Add Widget palette. To edit the widget’s properties, right-
click the Widget and click Properties.

GsSlider

Property Description

Track Width Width of the slider track in pixels.

Track Color
The color of the slider track. To change 
the track’s color, enter the name of the 
color into the field.

Thumb Color
The color of the slider control/bar. To 
change the color, enter the name of the 
color into the field.

Minimum Value The lowest possible value that the 
widget can display.

Maximum Value The highest possible value that the 
widget can display.

Thumb Width Width of the slider control/bar in pixels.

Thumb Height Height of the slider control/bar in pixels.

To change the value of a setpoint, click the slider bar and 
drag it up or down to the new setpoint. It will pop up an 
override window for you to override the point value. After 
that, the new overridden setpoint value will be displayed on 
the widget.

Zone Widgets

To use this feature, add a new GsZone or 
GsZoneCircuitStatus widget, move and size it to cover the 
area that the new screen should be based on, and then on 
the widget’s right-click menu, click Convert to Sub-Screen.

Converting to Sub-Screen

Naming the sub-screen.

Name the Sub-Screen

Saving the sub-screen and reload it.

Save the Sub-Screen

8.15.14   Zone Widgets

Zone widgets allow you to create a new GS screen based 
on a portion of another screen.
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Sub-Screen

8.15.15   Common Properties

Right-click on any Widget, click Properties, and you will 
see Common Properties section displayed in the first area in 
the widget properties. It applies to all types of widgets. 

Common Properties

After clicking OK button in pop-up window. The subscreen 
will be shown.

Property Description

Description Short descriptive information or name 
of the widget.

Tool Tip

The text you enter in this field will 
appear when you mouse over the 
widget. Information about particular 
points associated with the widget, 
widget name, and more, can be 
entered in this field. If no text is 
entered, the regular menu will be 
available.

Left The number of pixels the widget is 
from the left.

Top The number of pixels the widget is 
from the top.

Link GS Screen

Linking GS Screens: If you link from one widget to another 
GS Screen, enter the link path and link screen (simply the 
actual name of the GS Screen). For example, add a push-
button widget (GsPushButton) that will allow you to jump 
to another GS Screen. For the push-button widget on its 
Properties menu, enter the name of the GS Screen you 
wish to link to in the Link field.

Linking Gs Screen

Property Description

Z-Index Reflects the stacking order of position.

Width The width of the widget in pixels.

Height The height of the widget in pixels.

Lock Size/
Position check 
box

If enabled, values entered in the size 
and position properties fields will be 
locked. Any more changes made 
to these properties will not apply as 
long as the check box is enabled. To 
unlock and disable, click to remove 
the check-mark.

Visibility Qualifier
When true, it will make the widget 
or group visible, and when false, will 
make the widget or group disappear.

Reverse-direction linking: To link a GS screen in the 
reverse direction (backwards) from where you are on the 
tree, enter ../ in the Link Path field for each node of the tree 
you are going up, including the node you start from. Then 
add the name of the last tree node the GS Screen will be 
linked to. For example, if you begin at the Unit level in the 
tree and the GS screen is to be linked at the Site level:

•	 Site - Test Site 1 (your ending point)

•	 CS - Control System 1

•	 Unit - Controller 1 (your starting point)
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Enter ../../../Test Site 1 in the Link Path field.

•	 Link: If the GS screen you wish to add to is named “AHU”, type 
the text “AHU” into this field. Note that a URL address can also 
be entered into this field. When in Run mode, click that widget 
to go to the link you entered. Be sure to include “http://” or 
“https://” in the URL address.

•	 Link Path: The link path is how to get to the node of the tree 
you want to go to from where you are now. If the Link Path 
field is blank, it is assumed that the screen will be loaded at the 
same Tree node where the current screen has been loaded. 
This can be done by entering a “relative” path (preferred) or an 
“absolute” path. For example, the fields would be populated 
with the “relative” path information below when linking the 
push-button widget to the AHU GS Screen: 
 
Links: AHU 
 
Link Path: ABC Bldg/ABC E2 Bldg/BX-400 1: Suite 101/Air 
Handlers (AHUs)/RTU1 - OFFICES 
 
Unique parameters that can be specified as the Link on any 
widget:

	» ${home} when this link is clicked on the widget, it causes 
you to leave the current screen and go to the GS screen 
home page (if defined). If no home page is defined, or if you 
are already on the home pages, a pop-up error message 
will appear.

	» ${back} when this link is clicked on the widget, it causes 
you to leave the current screen and go back a page (just 
like the browser back button).

	» ${forward} when this link is clicked on the widget, it causes 
you to leave the current screen and go forward a page (just 
like the browser forward button).

	» ${graph} when this link is clicked on the widget, the 
associated points will be graphed that opens in a separate 
window. If no points have been associated, an “Invalid 
Reference” message will appear.

	— ${graph,N...} will graph a different point (where 
N is a reference number for a valid reference 
in the widget). For example, ${graph,1} will 
graph the point specified by reference 1. You 
can include multiple references in the graph 
by separating them with commas; for example, 
${graph,0,1,2} will graph the points specified by 
references 0, 1, and 2 on the popup graph.

	— ${graph}ScreenName optionally, you may 
follow the ${graph} link with the name of 
a screen to show as part of the graph. For 
example, ${graph,1,2}GraphSubScreen would 
pop up the log graph for the points specified by 
references 1 and 2, and also load the GS Screen 
named GraphSubScreen as part of the pop-up 
graph. The GS screen used in the pop-up graph 
must be specially designed for this purpose.

	— ${graph, 1, ...N}GsscreenName|24 sets a 
default time period for the pop-up graph (where 
|24 is the number of hours that can range 
from 1 to 4320). For example, ${graph,1,2}
GraphSubScreen|8 will pop up a log graph for 
points specified by references 1 and 2 within 
the last 8 hours and also load the GS Screen 
named GraphSubScreen as part of the pop-up 
graph.

	» ${tree} applied by default to the screen link path when a GS 
screen is created, this link parameter causes the navigation 
tree to synchronize automatically to the location where the 
GS screen is loaded. By simply clicking on the widget, you 
can see exactly where in the tree the GS screen is loaded.

	» ${0.siteID} this is the ID of the site this point is in.

	» ${0.controlsystemID} this is the ID of the control system 
this point is in.

	» ${0.unitID} this is the ID of the unit this point is in.

	» ${businessAction}businessActionName creates a link 
from the current GS Screen to a business action UI screen 
(where businessActionName is the exact business action 
name that is defined in the business-ActionDescriptor.xml 
file). By clicking the widget, the page will load the business 
action screen.

Link GS Screen to PDF 

In addition to linking a GS Screen to an external URL or to    
another GS, a GS Screen can be linked to a PDF.

Place the PDF on a server under the following path:  
\Tomcat\webapps\copeland\vault\tmp.

Add the URL link into the link field of widget property using 
the format: “http://” + pdf path + pdf name.

For example:

GS Text
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Link GS Screen to other Feature/Function screen

Link GS Screen to a feature or function within Connect+.

To link a widget to a Connect+ feature or function, enter 
a business action parameter in the Link field under the 
Common Properties section. Use the input format below.

Business Action Parameters

•	 ${businessAction}: a string constant. Enter this string in the 
Link field followed by the business action name of the feature 
or function.

•	 businessActionName: the string name of the feature or 
function as listed in the “businessActionDe-scriptor.xml” file 
(the Connect+ feature or function the GS will be linked to). For 
example, the business action name for configuring a site is 
EditSite.

Set a parameter name and a parameter value to features 
and functions that require a parameter. Type = (equal sign) 
in between parameter names and values and a semicolon 
(;) in between parameters, if more than one parameter is 
needed.

•	 paramName: the string name of the parameter being looked 
up. Refer to below table for list of parameters for a given feature 
or function.

•	 paramValue: the value of the parameter being referenced.

The required parameters should be entered in the Link field or an error message will display. Parameters can be entered in any 
order as long as the parameter names and values provided are valid.

Feature/ Function Screen Business Action Name Required Link Parameters

Edit Site EditSite ${businessAction}EditSite;referenceId=${0.
siteID};referenceTreeLevel=1;referenceName=${0.siteName}

Add Control System AddControlSystem ${businessAction}AddControlSystem;referenceId=${0.
siteID};referenceTreeLevel=1;referenceName=${0.siteName}

Edit Control System EditControlSystem
${businessAction}EditControlSystem;referenceId=${0.
controlsystemID};referenceTreeLevel=1;referenceName=${0.
csName}

Obtain Controller Information SyncControllerDirSite ${businessAction}SyncControllerDirSite;referenceId=${0.
siteID};referenceTreeLevel=1;referenceName=${0.siteName}

Obtain Controller Information ControlSystemInventory
${businessAction}ControlSystemSynchronize;referenceId=${0.
controlsystemID};referenceTreeLevel=2;referenceName=${0.
csName}

Obtain Controller Information UnitSynchronize ${businessAction}UnitSynchronize;referenceId=${0.
unitID};referenceTreeLevel=3;referenceName=${0.unitName}

Refresh Units ControlSystemInventory
${businessAction}ControlSystemInventory;referenceId=${0.
controlsystemID};referenceTreeLevel=2;referenceName=${0.
csName}

Refresh Application UnitInventory ${businessAction}UnitInventory;referenceId=${0.
unitID};referenceTreeLevel=3;referenceName=${0.unitName}

Retrieve Logs Site Level GetPointLogsSiteLevel ${businessAction}GetPointLogsSiteLevel;referenceId=${0.
siteID};referenceTreeLevel=1;referenceName=${0.siteName}

Retrieve Logs CS Level GetPointLogsCSLevel
${businessAction}GetPointLogsCSLevel;referenceId=${0.
controlsystemID};referenceTreeLevel=2;referenceName= 
${0.csName}

Retrieve Logs Unit Level GetPointLogsUnitLevel ${businessAction}GetPointLogsUnitLevel;referenceId=${0.
unitID};referenceTreeLevel=3;referenceName=${0.unitName}

Terminal Mode InitialTerminalMode ${businessAction}InitialTerminalMode;referenceId=${0.
unitID};referenceTreeLevel=3;referenceName=${0.unitName}

Forward Advisory FORWARD_ADVISORY ${businessAction}FORWARD_ADVISORY;referenceId=${0.
siteID};referenceTreeLevel=1;referenceName=${0.siteName}
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Feature/ Function Screen Business Action Name Required Link Parameters

View Historical Advisory VIEW_ADVISORY ${businessAction}VIEW_ADVISORY;referenceId=${0.
siteID};referenceTreeLevel=1;referenceName=${0.siteName}

Advisory Receiver Commission MonitorCommissioning 
RFDActivity

${businessActionMonitorCommissioningRFDActivity;r 
eferenceId=${0.controlsystemID};referenceTreeLevel=2; 
referenceName=${0.csName}

Live Advisory View CS Level GetLiveAdvisoriesCS 
LevelActivity

${businessAction}GetLiveAdvisoriesCSLevelActivity;referenceId= 
${0.controlsystemID};referenceTreeLevel=2;referenceName= 
${0.csName}

Live Advisory View Unit Level GetLiveAdvisoriesUnit 
LevelActivity

${businessAction}GetLiveAdvisoriesUnitLevelActivity; 
referenceId=${0.unitID};referenceTreeLevel=3;reference 
Name=${0.unitName}

Backup Site BackupSiteActivity ${businessAction}BackupSiteActivity;referenceId=${0.
siteID};referenceTreeLevel=1;referenceName=${0.siteName}

Backup Unit BackupUnitActivity ${businessAction}BackupUnitActivity;referenceId=${0.
unitID};referenceTreeLevel=3;referenceName=${0.unitName}

Backup Control System BackupCtrlSystem 
Activity

${businessAction}BackupCtrlSystemActivity;referenceId=${0.
controlsystemID};referenceTreeLevel=2;referenceName= 
${0.csName}

8.15.16   Set System Home Page

Locate at the My Info icon, click Set As Home Page to set a 
GS Screen as your home page and overwrite any previously 
set GS Screen system home page.

Home Page Option

A confirmation window will appears, click OK to set the 
GS Screen as your new system home page or Cancel the 
setting. 

Confirmation Message

After clicking the OK button, another message will show to 
tell you the system home screen is set successfully.

OK Button

After system home page is set, user will see the system 
home screen when landing to the Connect+. There’s a 
menu My Home Page listed under the My Info icon and 
user can select this menu to jump to system home screen 
from other page.

My Home Page Option
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8.15.17   Set Site Home Page

Setting a GS Screen as the Site Home page makes the chosen GS Screen as the landing screen for a given site. To set the Site 
Home page, while on the edit mode of a GS Screen, click the site Home icon from tool bar menu.

Gs Screen Site Home Page Widget

You could see a pop-up window of GS Screen Site Home Properties.

Gs Screen Site Home Properties

Set As Global Site Home Page: Check this check-box will allow all the users see the home page.

Set As My Site Home Page: If check this check-box, only the user who set the property can see the home page.

You can only choose one check-box, then click OK to save the configuration. To view the home screen by clicking the site 
name from tree node.

8.16   What Else You Can Do with Graphical Screens

You can right-click on Point Value and Override a Point, and also Display Log Graph, Real-Time Graph and view advisories for 
the point. You can also override a point from graphical screens. Note that you can only use the right-click menu in the Point 
Value field.

Refrigeration Summary
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8.16.1   View Real Time Graph

While you can view point log graphs from the Advisory View, Advisory Email, Watch Points, and Graphical Screens, you can 
only view point real time graphs from graphical screens.

The Real Time Graph allows you to watch the point value change in real time for different time intervals from five (5) minutes up 
to one (1) hour. You can also add more points from the graphical screen to the real time graph by right clicking the point value. 
The point path will be displayed in the real time graph.

Real Time Graph
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9.   Points

You can view details about controller points, graph points, 
retrieve logs, and make changes. Click the Active Points 
drop-down menu located in the center of the navigation 
window for point viewing options. 

Points Categories 

•	 Active Points is the default each time the user starts up the 
browser and will show all configured points in the controller.

•	 Active w/ Logs shows active points that have a controller log 
available.

•	 Points w/ Logs shows points that have a controller log 
available.

•	 All Points shows all possible points for an application instance, 
whether it is configured or not. An icon will appear next to the 
point if the point has a log.

You can select points to watch or graph using the check boxes in the tree, or load points from a 
list. (refer to Section 10   List Power Builder)

Select Points to Watch From the Tree Load Points From a List

9.1   Watch Points

When you click the Watch Points icon       , you will be directed to Watch or the Graph Points 
page.
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In the example below many points are contained in the review area. Click Watch Points at the bottom right corner.

Wait several seconds for Connect+ to establish the real time communication to your controllers. You will see the value change 
from “?” to meaningful values. If you see the value shows “---”, please check your device connection.

In the Watch or Graph Points Page, besides the Watch Points’ real value, you can also:

•	 Display Log Graph, Retrieve Logs and Export for multiple points selected.

•	 Right-click on each point to access Display Point Graph, Real Time Graph, and View Advisories.

Click on Watch Points

Click on Watch Points

Other Points
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9.1.1   Display Log Graph

We have introduced how to read log graph in the Advisory View session. You can also choose to Display Log Graph from 
Watch Points.

•	 If you want to see an alarming point’s log graph, right-click on the point name and choose Display Log Graph. The log graph you see is 
the same as the one you see from the Advisory View.

•	 If you want to see multiple points’ log graph, just click Display Log Graph, all selected points’ log graph would be shown for the same 
time period. 

If the point log has not been retrieved, you need to retrieve logs first. or choose Retrieve Logs + Graph, it will retrieve the logs 
before showing the graph.

9.1.2   Retrieve Logs

If the points you selected do not have logs retrieved, consider retrieving logs first and then displaying the log graph.

When you Retrieve Logs, Connect+ will display the Activity progress:

Display Log Graph

Retrieve Logs
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Upon completion, you can go to the Header Menu > Activities > View My Activity History to check the Retrieve Logs status.

9.1.3   Export

You may also want to export log data for these points. Click Export, fill the time range and click Go. Export will be in progress. 
Upon completion, an Excel file will be downloaded to your computer. If the points log has not been retrieved, you need to 
retrieve the logs first, or choose Retrieve Logs + Export.

Retrieve Logs

Export

9.2   Override Point

You can override input points and output points from Navigation Tree, Watch Point List or a graphical screen.  When you right-
click on point value, you will see Override in the right-click menu. To override, enable the Override check box.

Watch or Graph Points
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If Timed is selected, you must enter a time in the field. A point value will be overridden for a time period as specified after you 
click OK. The point of Site Supervisor only supports the Timed override.

Fixed Override Point

Timed Override Point

If you enter Fixed and a value, that point value would be overridden permanently until further changes are made.
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9.3   Modify Points

You can modify parameter points from Navigation Tree, Watch point or a Graphical Screen.

Modify Parameter Points

Case Alm Hi
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10.   List Power Builder

You can create, view, edit, and delete the list with the list Power Builder tool and quickly select it from watch point page to view 
the real time value. Power Builder creates large-scale lists by specifying a filter or matching criteria of items to add or remove 
from a list instead of using each item in the list individually; as a result, large lists can be built quickly.

The list power builder window can be launched from 3 different places in Connect+: The Watch Points screen, Schedule 
Manager page when scheduling the Retrieve Logs by List, and from the Setpoint Broadcast Scheduler configuration page.

List Power Builder

The title in the top left will vary depending on the type of lists that the power builder is currently working with. This can be 
Watch Points Lists or Target Controller Groups Lists, depending on where the Power Builder was launched from. The Watch 
Points Lists are used both on the Watch Points page and for Retrieving Logs From List, it enables you to create and save 
several lists. It only can create one list from Target Controller Groups page, and then use it for setpoint broadcast.
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List Power Builder from Target Controller Group

When adding a new list, type in the list name in List Name 
field, and you will see a Save as new list button, click it to 
save the list.

Save as New List

The Load List drop-down menu displays all the Lists 
being worked with. Choose the list you wish to work on. 
The related points will be shown in the below table. If you 
update an existing list, you will see an Unsaved changes: 
List has been modified message appears. Click the Update 
List button to save. You can also rename the existing list 
from List Name field, and then click the Update List button.

Update List

Select one list and delete it by clicking the Delete List 
button. 

Save as New List

The Public List check box indicates whether or not the list 
is public. Public lists can be viewed by all users and private 
lists are only visible by the list owner (user who created the 
list.) Check or uncheck this box to toggle lists to private or 
public (applicable user privileges apply). 

You can add the search criteria from the Criteria section (top 
right), if a Directory, Site, Control System, Unit, Application 
Type, Application Instance, Point, or any combination to 
add all elements that match those names into the list. If 
a name is added without wildcard symbols (*), the exact 
name must match.
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Search Criteria

To match a partial name, place an asterisk wildcard symbol at the beginning or end (or both) of the name match. For example, 
to add all points that are under Application Instances with a name beginning with GLOBAL, enter GLOBAL* in the Application 
Instance field and click Add to List. Multiple entries may be typed into one field by separating the multiple entries by commas. 
For example, if you wanted to add everything under sites, East, West and North, enter East, West, North into the Site field. This 
applies to all the field.

Search Multiple Entries
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A list of sites can be copied to the clipboard from an external text file (from Notepad for example, or Microsoft Word or Excel) 
and pasted into the criteria Site field. The site names should be one site name per line and/or comma delimited on a single line 
or multiple lines. The user can simply cut or copy the list of sites into the Site field. When the user clicks the Add To List button, 
the sites will be verified for matches simultaneously as the Add To List function is occurring, and any that don’t match will be 
displayed at the top of the window for informational purposes so that the user can update their source list of sites if desired.

Site Field

Click the Remove All Items button above the table to clear all points from the list.

You can filter on each column element from the filter field.

Filter Field

After filtering, you will see Remove Filtered Items and Clear Filter buttons are displayed. Click Remove Filtered Items to 
remove all filtered items from the list with one click. For example, when this button is clicked, all values shown with ‘152’ in the 
site name would be removed from the list.

Click the Clear Filter button to clear all the filter fields. Uncheck the check boxes to the left of each element to remove single 
elements from the list.

The number of filtered elements, the total number of elements in the list, and the current view range are displayed at the 
bottom of the page. The size of the list (List Size) is displayed at the top of the list.

Use the Prev and Next buttons                                at the bottom of the table to page through results. Choose the amount shown in 
the list with the Page Size drop-down.
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11.   Access Control

Monitoring your store from an Advisory Map, Graphical Screen, or Watch Point Lists may not always be sufficient. Connect+ 
allows you to connect to your controller remotely to access the controller to change settings or get more information.

11.1   Terminal Mode

You can remote login to Terminal Mode. You can access Terminal Mode from two places: Right-click menu at the controller 
level or from the Advisory View controller link.

11.2   Controller Logs & Stats

You can also view Controller Logs & Status from the right-click menu at the controller level. Below is a list of  
Controller Logs & Status Reports you can view directly from Connect+:

•	 Monitor Master

•	 Monitory Relay

•	 Check Status Usage

•	 Communication Statistics

•	 Schedule Statistics

•	 CPU Usage Report

•	 Description File Report

•	 Free Memory and Disk Space

•	 License Report

•	 System Logging Report

•	 Task Details Report

•	 Task Statistics

•	 Assertion Log

•	 Exception Log

•	 Maintenance Log

•	 Monitoring Connection Log

•	 Monitoring Log

•	 Monitoring Pending Log

•	 Override Log

•	 RMS Log

•	 Service Log

•	 Stpt Change Log

•	 System Update Log

•	 User Access Log

Terminal Mode
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11.3   Network Status

You can view Network Status from the right-click menu on both the Control System and Unit levels. Network Status provides 
real time controller/device connectivity. You can view if a controller or a device is online or offline from Network Status screen.

Controller Logs and Stats

Network Status
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12.   Controller Activity

We have covered Point Level Activities such as Override/Modify, Display Log Graph, Real Time Graph in Advisory, Graphical 
Screen & Watch Point Session. This session will cover Controller Activities from the Navigation Tree right-click menu.

12.1   Refresh Controller & Application

Obtain Controller Information

The Obtain Controller Information activity connects to a given Control System, refreshes the Unit list, refreshes the Application 
List for each Unit, and refreshes the points for any Application Instances that have “out of date” points, which means the point 
list will be retrieved for any applications that have never had a point list retrieved, and also for any applications that have 
changed since the last time the point list information was checked.

Obtain Controller Information will need to be run (or equivalent operation) for Connect+ to display the current information in 
the controller and synchronize the updates from the controller configuration and the GS Screen. Note that if the configuration 
of the controller changes while a GS Screen is being viewed, the system will not pick up configuration changes between the 
time the application data inventory is being received. 

Refresh Unit

Refresh units is an activity that may be performed at the control system level. When a Refresh Units is performed, information is 
pulled from the controller and is posted to Connect+.

Right-click on the desired Control System from the main Navigation Tree to bring up the pop-up menu and select Refresh 
Units. Once this activity has been triggered, the Activity Status page will be displayed. 

Refresh Application

Right-click on the desired unit from the main Navigation Tree to bring up the pop-up menu and select Refresh Applications. 
Once this activity has been triggered, the Activity Status page will be displayed.

When the activity has completed successfully, the changes, if any, will be evident automatically on the Navigation Tree under 
the selected unit or click the Refresh button in the navigation frame. 

Refresh Point List

Refresh Point List is an activity that may be performed only at the Application Type and Application Instance levels on the 
Navigation Tree. When a Refresh Point List is performed, information is pulled from the controller and is posted to the 
database.

Right-click the desired application type or instance from the main navigation tree to bring up the pop-up menu and select 
Refresh Point List. Once this activity has been triggered, the Activity Status page will be displayed.

When the activity has completed successfully, the changes, if any, will be evident automatically on the Navigation Tree under 
the selected application or click the Refresh button in the navigation frame.
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12.2   Manual Defrost

Manual Defrost allows users to start a defrost for a freezer or refrigerated 
case that is outside its normal scheduled routine. Manual Defrost is 
available only for supported controllers (E2 and Site Supervisor) and 
applications (Standard Circuits, Case Control Circuits, XM Circuits and 
MultiFlex CUB).

To start a manual defrost, right-click the application instance (circuit) 
where the freezer or refrigerated case to be defrosted is associated, and 
click Manual Defrost.

The Manual Defrost box will appear with the name of the application instance displayed.

Once set, the manual defrost command is sent to the controller. Details of the Manual Defrost activity (whether Completed or 
Failed) will be recorded in the Activity History page.

Manual Defrost

Manual Defrost with Application Name

Activity History Results
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When Bypass is selected, a drop-down list appears and contains different types of Manual Defrost to choose from:

a.	 Defrost - Puts the unit in its normal defrost routine.

b.	 Emergency Defrost - Begins defrosting immediately. This event continues until the bypass is removed.

c.	 Start Cleaning - Starts the clean or wash mode. Refrigeration cycle ends without any defrost action. The normal 
time programmed for cleaning mode also applies.

d.	 Refrigeration Override - Appears only if the Application Instance is a MultiFlex CUB application.

A message displays if the Application Instance on which Manual Defrost is being run does not have data in the database. In 
this case, run a Refresh Point List first and configure the manual defrost again. 

12.3   Backup & Restore Controllers

Backup can save setpoint information from a controller to 
the Connect+ server and the activity can be completed at a 
directory, site, control system, or unit level.

Backup Controllers

After backup, Restore can pull the backed-up setpoints 
from the database and restores the data back into the 
controller and is then started from the unit level.

You can configure a backup daily schedule to back up the 
setpoint file, and if your controller encounters any issues, 
you can restore the backed-up setpoints back to the 
controller. 

Additionally, some stores may have similar distribution and 
management. In this case you can configure and back up 
setpoints on one controller and restore to another.   

Restore Controllers
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Configure Backup

Connect+ will reserve the latest four backup records by 
default. You can configure how many records you want to 
reserve from the right-click menu File > Configure Backup.

You can use the default value or choose Enter a value, 
1-100, specifically for this item and specify a backup kept 
number.

Configure Backup

Number of Backups to Keep

Kept backup items will be listed in the table, which you can 
check for the items that you wish to keep forever by clicking 
the Keep Forever check box. Additional comments can be 
added for each backup record.

Export Setpoint File:

You can also view and export backup records in the Export 
Setpoint File page. Select File > Export Setpoint File from 
the right-click menu of unit level.

Setpoint File Export

Click the Export button for each backup record to download. Each protocol will have a different setpoint file extension. 
Setpoint file for E2 is .e2b. Site Supervisor and E3 is .adf and XWEB is .backup.xweb.

12.3.1  Backup

You can right-click the menu and select File > Backup on directory, site, control system, or unit level to execute activities. 

When you execute the backup activity on the directory or site level, the Activity Startup page will display, and you can 
configure the activity to Run Now or Run On Schedule. A unit is needed for backup activity.

After a backup has been completed successfully, you can view backup records on unit properties that can be accessed from 
the right-click menu Configure > Unit Properties of the unit level. The total items displayed in the unit property is based on the 
configuration in Configure Backup.

Backup on Directory
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12.3.2   Restore

To restore a unit, click right-click the menu File > Restore on the unit level and choose the configuration of the Restore activity:

Activity Startup

•	 Restore from a backup Image from the current unit - Restores 
the current unit using the backup file chosen  
from the list of backed-up setpoints. Click the radio  
button of the backup that you wish to restore to the  
unit and click Go to Restore.

•	 Restore from another Unit’s backup Image - Restores the 
backup file from another controller to the current unit. To 
restore, click the Select another unit to restore from button. 
A Select Another Unit pop-up window opens and displays 
the navigation tree. Choose the unit from where the current 
unit will restore.. Expand the navigation tree down to the unit 
level, select the radio button of the unit, and then click Select. 
After configuring, backup records for the original unit will be 
displayed and you can choose a desired setpoint file to restore.

Selecting Another Unit
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Selecting Another Unit to Restore From

•	 Restore from a file - Restores the current unit using a setpoint file data (.E2b/.SSBackup/.backup.xweb). Click the radio button in this 
panel and then select the setpoint file to load from the Select File To Upload drop-down list. 
 
If you want to restore from a local setpoint file, click the Browse button, locate the setpoint file on your computer, and click Open. Note 
that only setpoint files with matched protocol types can be uploaded. For example, if you want to restore setpoint for Site Supervisor and 
E3, you should upload SSBackup file; otherwise, an error message displays. 
 

Warning

If Connect+ finds a duplicate file name in the database, a message window will display and ask if you want to overwrite the old file. Click 
Overwrite to import the setpoint file and overwrite the old file or Cancel to cancel file import. After configuring Restore, click Go.

An activity status page opens with a progress bar that shows the status of the Restore activity and the percentage of 
completion. After restoring is completed, the controller will be restarted to apply the backup data.
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12.4   Controller Description Files   

12.4.1   Upload Description Files

A description file is a template file used to add an 
application type or new device into the controller. 
Description files can be uploaded from the directory, site, 
control system, and unit levels from the navigation tree  
File > Upload Description Files or accessed from the 
Admin Tools > Schedule Manager.

If you want to run the description file one-time only, choose 
Run Now and the Activity Startup page will open where 
you can click the Browse button to locate the description 
file you wish to upload to the controller. If the description file 
is to be uploaded at a later date, select Run On Schedule 
and configure it from the Schedule Manager page. Note 
that this Activity can be scheduled, but not recurring.

Running the Upload Description File activity now from the 
Activity Startup page:

Upload Description File

Connect+ supports three kinds of description files for 
different controller type. You can upload .dsc file for E2, .adf 
file for Site Supervisor and E3 and .zip file for XWEB.

Click the Browse button to locate the description file. When 
Browse is clicked, you can select a single description file to 
upload from a File Open popup and click Open to upload 
the selected file to the Connect+ server. If the file name with 
incorrect extension is uploaded, a pop-up error window will 
be displayed indicating that there was an invalid file type 
selected and that only file types of .dsc, .adf and .zip are 
allowed. Once the file is selected, the file will be uploaded 
to the Connect+ server and you will be redirected to the 
Schedule Manager page previously viewed and the file 
will be added and selected to the list of available files in the 
Description File To Upload drop-down list.

If the file to be sent to controller already exists in the 
database, it will appear in the drop-down list. Select the file 
that will be sent to the controller from the Description File 
To Upload list. The selected description file should match 
the controller type or the activity will fail.

The description file will be applied after the controller is 
rebooted. You can Enable the Reboot controller(s) after 
upload check box to automatically restart the selected 
controllers after the upload and allow them to recognize the 
description file that was uploaded. Afterward, you can add 
the application or device for the uploaded description file.

12.4.2   Remove Description File

You can remove description file from the unit level. Right-
click on unit, select Files > Remove Description File. The 
uploaded description file will be listed in the table. You can 
choose the file that you wish to remove by clicking the 
check box in front of the file name, and click the Delete 
from controller button. The description file will be removed 
from the controller.

Remove Description File.
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12.5   Edit Application

To make changes to an application instance, choose Edit 
Application page from navigation tree. Right-click the desired 
application instance from the navigation tree and select Edit 
Application Instance. 

Edit Application Instance Menu

Edit Application Page

The Edit Application page allows you to perform online remote editing of applications and shows the editable and non-
editable point values (or protocol component) of an application instance, which are divided into groups set by the controller. 

Each application instance is divided into groups of points. Each group is a tab that contains point names and values.

•	 The left column shows the names assigned to points (pre-configured in the controller). Hover the cursor over the names to display its 
description in the Additional Info panel.

•	 The right column contains fields where you can enter your changes to point values (can be either editable or non-editable depending on 
the controller’s setup). Values can be of the following types: text (enter the value in the field provided), drop-down (expand and select 
from the list), or check box (click to enable/disable the indicated property). Use the arrow keys on your keyboard to move between values 
within a tab.
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Full Options/Reduced Options toggle button allows you to select the display mode for points. (When Full Options is displayed, the 
Reduced Options mode is in use, and vice versa.). Full Options allows you to view more points than in the Reduced Options. By default, 
the page is set to Full Options; click the toggle button to shift modes.

•	 Advanced Access and Normal Access 
 

Click Advanced Access and Normal Access toggle button 
to display Level 5 properties in the page. A pop-up window 
will appear on the page and ask you to enter a valid one-
day password. Click OK after entering the password. If the 
password is correct, the user will be able to view additional 
fields that were not available previously. If the password that 
was entered is invalid, an error pop-up message will display, 
and the screen remains unchanged.

•	 Print Current Tab/Print All Tabs

•	 Print Current Tab/Print All Tabs: The print buttons beneath 

the window give you the ability to print point information. If 
a print button is clicked, all point information displayed will 
show in a new window. Click Print Current Tab to print the 
information that is related to the tab you are currently viewing 
or click Print All Tabs to print all the available point information 
in all tabs.

Sample Print

If you change the point name, there will be a Lightning bolt icon          to the left of the point names to indicate the point value 
has been changed.

If a change was not saved to the controller after clicking OK, the page is enabled, and a message appears on top of the page 
along with a link to Activity Details. The page will then wait for more input.

•	 Full Options/Reduced Options 
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You can configure Pointer, Log, Advisory or Bypass for E2 
point in Edit Application page by clicking the icon behind 
the point.

Bypass Option

Pointer Configuration

If a point is capable of becoming a pointer, the Pointer 

Configuration icon            appears to the right of that point 
value; click this icon to open the Pointer Configuration  
pop-up window:

Pointer Configuration

The Pointer Configuration window allows you to define a 
point within the same control system to which the current 
point being configured will get or send its property.

To set up a pointer, select a value from each of the  
drop-downs:

•	 Area Controller - the area controller to which the point will 
associate (should be the same control system of the current 
point).

•	 Application Type - the name of the application type.

•	 Application - the specific application to which the point will 
connect.

•	 Point - name of the input or output you want the current point 
to send or get its value from. Connect an input point to an 
output point of the same data type, and vice versa (for example, 
digital outputs to digital inputs, analog inputs to analog 
outputs). An input point cannot be associated to another input 
point, likewise, an output point cannot be hooked to another 
output point.

Example 1: A time schedule that has a digital output that is 

turned on and off based on time is hooked to a digital input 
of another application to perform a bypass action based on 
the time of day.

Example 2: An analog combiner with four temperature 
inputs can average the inputs and have the average as 
the output value. The output is connected to the input 
of another application to control off of the average 
temperature.

Click OK to save the settings; pointer information will 
display in the Value field of the Edit Application page. Click 
Cancel to exit.

Each output point that has the ability to be a pointer can 
point to multiple other input points within a controller. To 
connect an output point to multiple input points, click the 
Pointer Configuration icon of an output. A pop-up window 
will open and display all the input points connected to that 
output. (The page will be blank if no point is connected 
currently.) Click to highlight an input point and click Edit to 
modify or click Delete to disassociate the point and remove 
from the list. To connect more points, click the Add button.

Pointer Configuration Menu
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Log Configuration

Grayed out icons appear when there is no log configuration 
or alarm configuration set up yet. Click on the grayed-out 
icons to set up a log configuration or advisory configuration 
for the first time.

Advisory Configuration 

Click the Advisory Configuration icon          to set up 
advisory parameters for the current point. This will configure 
advisories for this point only. Each point that needs advisory 
configuration will be set up separately. Click OK to apply 
changes or Cancel to exit the window without saving.

Advisory Configuration Menu

Bypass Configuration

If available, click the Bypass Configuration icon          to 
set up the bypass parameters. It can allow you to configure 
the command output to be bypassed to a fixed value by a 
switch or push button. The Bypass Configuration pop-up 
window will open. Click OK to apply and exit this popup or 
Cancel to exit without saving changes. 

Bypass can be set as No Bypass, Level, Momentary.

Level: Activated or de-activated by level where a normal 
switch is usually used: usually “ON” level of the digital input 
activates some specified event and the level bypass will 
follow the input; however, there is a timer associated with 
the level bypass which is used as a failsafe.  The duration is 
used to turn off the bypass after a certain time if the input is 
still on.

Momentary: Activated or de-activated by pulse where the 
push button is normally used: the corresponding digital 
input will scan for pulse (ascending edge and descending 
edge) to signal the start of the bypass. When the bypass 
is initiated, a timer will be used to control the length of 
the bypass. Once the bypass timer reaches the duration 
specified in the bypass timeout, the bypass will terminate. 
During bypass period, the bypass can also be canceled 
when the corresponding digital input detects a certain 
number (3 in our design) of pulses.

Bypass Type

Once all the configurations are completed on the Edit 
Application page, click Apply to send the configuration to 
the controller, you will stay on this page and can continue to 
edit other properties. Click OK to send the configuration to 
the controller and exit the page.

Log Configuration

You can set up log parameters of an application instance by 

clicking the Log Configuration icon          (available only for 
points that have logs). There are two possible types of log 
configuration: analog and digital. Information related to the 
point will appear when the point is clicked. Click OK to save 
or Cancel to exit.
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12.5.1   Edit Time Schedule

Right-click on the instance of Time Schedule and select 
Configure > Edit Application Instance. From here you can 
manage your schedule event through Edit Application 
page.

Time Schedule for E2

Time Schedule for Site Supervisor and E3

Schedule Type 

E2, Site Supervisor and E3 support two schedule types, 
the Master schedule and the Slave schedule. You can 
configure it from General tab.

Configure Schedule Type

Master schedules are the main scheduling unit used by E2, 
Site Supervisor and E3. A master schedule consists of up to 
15 scheduled ON/OFF event pairs of E2, and Site Supervisor 
and E3 support 20 events, which may be programmed to 
occur on any individual date and time or series of dates and 
times. Master schedules may also drive slave schedules.

Slave schedules are similar to master schedules, except 
their operation is driven by a master schedule.

Generally, slave schedules are alterations of the master 
schedule’s event times. The ON/OFF times in a slave 
schedule may take place either at specific defined times of 
the day or relative to the times given in the master schedule.

For example, a master schedule may be defined as: “The 
building is occupied from 8:00 a.m. to 9:00 p.m.” while one 
of its slave schedules be defined as: “Dim the building lights 
15 minutes before the store closes.”

Slave schedules may also be mastered by other slave 
schedules to create a series of stacked schedules.

Absolute and Relative Events

You can configure the schedule event from the Events tab. 
Events are simple commands to turn the schedule output 
either ON or OFF at a particular time within a range of days. 

Master schedule events always occur at specific times of 
the day. In other words, when you program an event pair 
in a master schedule, you must specify two specific times 
of the day the events will occur. These types of events are 
called absolute events.

However, when programming event times in slave 
schedules, you can choose to enter absolute events times, 
or event times that are relative to its master schedules ON 
and OFF times; these types of events are called relative 
events. They are programmed not as absolute times but as 
amounts of time before or after its master schedule’s events.

For example, set up a master schedule to be ON at 8 a.m. 
and OFF at 9 p.m. every day of the week, and you wish to 
set up a slave schedule so that its output comes ON 15 
minutes before the master comes ON and OFF 15 minutes 
after the master goes OFF. To do this, you would set up the 
slave schedule to come ON at -00:15 and OFF at +00:15 
every day of the week. The salve schedule will automatically 
determine the correct ON and OFF times. 
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Configure Number of Events

Manage Time Events

Increase the number of Num Std Events of E2 or Num 
of Events of Site Supervisor and E3 from the General 
tab when you want to add new schedule events. After 
increasing the number, the new empty lines will be added 
in Std Events tab of E2 (It is called the Events tab of Site 
Supervisor and E3) to let you add a new event.

New Events Added

For the same reason, you could remove the schedule 
events by reducing the number of Num Std Events, it will 
delete the last few events. For example, there are five time 
schedule events exist, and you reduce the Num Std Events 
from 5 to 3, then the events 4 and 5 will be removed.

When you configure the master and slave events, you may 
configure the conflict events of the date range. For example, 
a master event configured to execute on Monday and 
Tuesday, but a slave event configured relative to the master 
time at Monday and Wednesday. In this situation, the slave 
schedule will only be applied to the overlapped date, in this 
example, it will be applied on Monday.

12.5.2   Edit User Access

Users can be managed in the controller from Edit application page of User Access. Right-click on the instance of User 
Access and select Configure > Edit Application Instance.

User Access of E2
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E2 can enable up to 25 different users. You can configure username, password and access level from the User tab. 

Access level determines how many of the E2’s features the user may use. There are four access levels, one being the lowest 
and four being the highest. You can also configure it from Access Levels tab.

Access Level of E2

Different than E2, Site Supervisor and E3 use roles to manage feature usability. There are 5 default roles and 1 default user 
existing on the controller, and these default roles and users cannot be edited or deleted. You can add a maximum of 20 roles 
and users.

The role management function is only supported on Connect+ 1.5.6 and Site Supervisor and E3 2.24 versions and above.

User Roles of Site Supervisor and E3

User List in Site Supervisor and E3

If you want to assign a customized role to a user, you must 
add the role first.

Add a role or user by increasing the number in General tab. 
After the number is increased, you can see the empty row is 
displayed on User Roles or Users tab to let you add a new 
role or user. This number cannot be reduced.

Increase User and Role Number
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When adding a new role, you can select the template to help you enable some recommended privileges, so that you do not 
need to configure them one by one. You just need to modify it based on the recommendation.

Role Template

Once the role is added, it will be displayed behind each user in the Users tab, and you can assign the role to the user.

New Role Added in User Tab

Each user can only be assigned one role.You can delete the role or the user by enabling the check box before each role and 
user, or you can also delete multiples at the same time. After the role is deleted, it will be removed from the User tab as well. If a 
user is assigned with the deleted role, after deleting, the user will automatically be assigned to a default role of Non-Technical 
End User.

Delete User from Site Supervisor and E3

Delete Role from Site Supervisor and E3
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12.6   Setpoint Broadcast

Connect+ users can utilize the powerful Setpoint 
Broadcast feature to change the Controller Application 
Points Value or Points Configuration. Setpoint Broadcast 
allows users to define their own change template by 
selecting an existing application’s points, and next 
broadcast the specific changes to the Target Controller 
Group across Enterprise.

This enterprise level capability helps users reduce time 
tremendously when setting up a new store such as 
General Setup, Case Controller Setting Configuration, and 
performing regular updates, such as change User Access, 
and Lighting Schedule.

This section starts from general capability, and then 
specifies the details in most common scenarios such 
as User Access, Lighting Schedule, and case controller 
settings by using Setpoint Broadcast for changes. General Setpoint Broadcast Menu

If you have scheduled Setpoint Broadcast previously, you will see a list of Setpoint Broadcast entries. You can start from an 
existing entry and modify it to save as a new Setpoint Broadcast. Or you can choose Add New:

12.6.1   General Setpoint Broadcast

You can choose Top Menu > Setpoints > Setpoint 
Broadcast > Configure Setpoint Broadcast:

Schedule Manager

Once you click Add New, you will be redirected to a new page to configure Setpoint Broadcast Activity. 

You can choose Run Now if it is a one-time activity or Run on Schedule if it is regular activity.

If you choose Run Now, you do not need to provide a name for your Setpoint Broadcast Activity. It will run just once. 
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Activity Startup Menu

If you choose Run on Schedule, you must provide a name for the Setpoint Broadcast Activity, and specify a regular time for 
the activity to run: 

Setup Broadcast Details

You can choose Application Setpoint or Point Configuration Broadcast.
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Application Setpoint Broadcast allows you to broadcast point value changes. Most common scenarios such as User Access, 
Lighting Schedule, and case controller settings belong to this category, which will be addressed in the following sections.

Application Setpoint Group

Point Configuration Group

Point Configuration allows you to broadcast both Analog and Digital Point Configurations:
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12.6.2   Configuration

Test Send check box: (When Setpoint Broadcast is set 
as the type of Schedule) When this box is checked, a Test 
Send will perform all steps of an actual setpoint broadcast 
(except it will not actually execute the send). The message 
in red next to the Test Send check box will notify the users 
that selecting the check box will not actually send the 
values.

Configuration Tab

The Test Send, if selected, will connect to the device and 
retrieve any information needed to test for valid points. This 
test will show up in the Schedule Manager as a setpoint 
broadcast entry. There’s no need to recreate the schedule, 
just edit the schedule and unchecked the Test Send option 
(the details of the test will be available on the activity history 
page once the test has been completed). You will know that 
the setpoint broadcast was only a Test Send because it will 
be part of the activity history details message.

Retry on failed targets? check box: When this box is 
checked, Setpoint Broadcast will re-run automatically on 
sites that failed or did not complete the initial broadcast. 
Setpoint broadcast will continue to run on each of these 
sites until the activity is completed or until the set number of 
tries is reached (for scheduled Setpoint Broadcasts only). If 
the Set-point Broadcast fails on a number of target control 
systems after the set number of tries, a file containing 
information about the sites and control systems that failed 
the activity will be generated in a sub folder under the vault 
(database) folder.

Details of the retry activity will be recorded in the Activity 
History page once the setpoint broadcast is completed.

12.6.3   Application Setpoint Broadcast

Choose Change Template 

Once you have chosen Application Setpoint, click Add 
New:

Changing Template

Select an Application from the tree structure to start 
compiling your Change Template:

Selecting Application

Go through different point tabs to choose the point and 
enter the value you want to change:
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Point Tabs HT/CL Setup

Click Save and the Change Template is saved by the name you provided:

Saving the Template
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Choose Target Controller Group 

If there are existing Target Controller Groups for same application type, the mapping entries are filtered. Otherwise, you can 
Add New:

Target Controller Group

Filter the Target Group based on Criteria:

Filter Target Controller Group
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Saving Target Controller Group 

Choose Change Template and Target Controller Group and Click Go (Run Now) or Apply (Run on Schedule).

When you select one Application Setpoint Group for an application type, the matched Target Controller for the same 
application type will be filtered, you can only choose one Application Setpoint Group and one Target Controller Group for 
Setpoint broadcast activity.

Saving Target Controller Group 
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Check Setpoint Broadcast History

You can select Admin Tools > Setpoints > Setpoint Broadcast > Setpoint Broadcast History to view the setpoint broadcast 
activity result. It is including information such as the type of activity performed.

Setpoint Broadcast Activity History

Name: The Application Setpoint Group name when creating a new setpoint broadcast schedule.

Started: The time and date the activity began.

Duration: Total elapsed time for the activity to complete.

User: The user who started the activity.

Result: Details the outcome of the activity and whether or not it was successfully completed. (Clicking a link in the Result 
column will open a page contain more details about the activity performed.)

Setpoint Broadcast Details: Hover on the Show Detail button to see a tip to indicate XXX of XXX total applications have been 
updated. When the button is clicked, a pop-up window will list all the changed points and its original target value.
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Revert: It allows you to revert the point value by clicking the Revert button. You might see buttons with three names: 

             Revert: No points value have been reverted.

             Reverted: All points have been reverted.

            Partial Reverted: Parts of the points have been reverted.

You can revert to Application Setpoint Broadcast if necessary. Note that you can only revert once.

Setpoint Broadcast Details

 Activity History
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If you want to change the broadcast value back, you can click the Revert button. After clicking the button, it will jump to a 
Revert Activity page.

Revert Activity

If you wish to revert points back to their original value, choose the points that you want to change by clicking the check box in 
front of the row. Then click the Revert Changes button. The activity will commence.

User Access Change

1.	 Add an Application Setpoint Group and provide a 
name:

Add Application Setpoint Group

Add Application Setpoint Group

2.	 Select a User Access Instance from the User Access 
Application Type from the Tree structure to start your 
Change Template:
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User Access Template for Site Supervisor/E3 2.24 Below Version

But if the template is created based on Site Supervisor/
E3 2.24 and above versions, you can see the Role tab 
and broadcast it to the controller versions that support 
this function. 

User Access Template for Site Supervisor/E3 2.24 Above Version

To add a new user or a role by increasing the user or 
role number in the General tab, then you will see a new 
blank role in Users or Roles tab.  
 

If deleting a user or a role by enabling the check 
box before each user or role, make sure the lighting 
bolt of the delete check box is checked. If a user has 
been assigned a role that is deleted, this user will be 
automatically assigned to Non-Technical End User. 
 

If you want to remove all existing customized users 
and roles on the target controller at the same time, and 
replace with a batch of new users and roles configured 
in the template after broadcast, you can check the 
“Remove customized users and roles on controllers” 
check box in the General tab.

Remove User and Roles Check box

4.	 Select the newly added User Access Application 
Setpoint Group. You can either click Add New in the 
Target Controller Group, or choose an existing Target 
Group.

User Access

NOTE: If you have a template created for User Access 
before upgrading Connect+ from 1.5.6 below to 1.5.6 
and above versions, you should create new template 
for User Access.

3.	 Add/Delete a new user or role, select user information 
by clicking the lightning bolt and Save. The lightning 
bolt icon indicates the change to be applied. Click 
Save, and your Change Template is saved. 
 
NOTE: Only Site Supervisor and E3 2.24 and Connect+ 
1.5.6 and above versions can support role broadcast. 
E2 does not support role management. 
 

If you create a User Access broadcast template by 
choosing a controller below version 2.24, you will not 
see the Role tab. 
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5.	 The Target Controller Group window will display. The List Power Builder allows you to choose the Target Group by 
filtering the Application Type with User Access:

List of Power Builder

Selecting the Target Controller Group

6.	 Select the Target Controller Group and click Go. User Access will be broadcasted:
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Lighting Schedule Change

1.	 Add a new Lighting Application Setpoint Group and provide a name:

2.	 Select a Lighting instance under the Lighting Control Application Type from the tree structure:

Lighting Application Setpoint Group

Lighting Instance
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3.	 Click the lightning bolt in front of the point you wish to broadcast. The Std Events could be used for the Lighting 
Schedule:

Std Events Option

4.	 Select the newly added Lighting Application Setpoint Group. Add a new Target Controller Group of Lighting from the 
Target Controller Group window, by filtering Application Type using Lighting Control.

Lighting Control Menu
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5.	 Select the Target Controller Group and click Go. Lightning will be broadcasted:

Lighting Control

Time Schedule Change

1.	 Add a new Time Schedule Application Setpoint Group 
and provide a name:

Adding Time Schedule

2.	 Select a Time Schedule instance from the simulative 
tree. 

 
If the instance selected from the tree is a master 
schedule, it could only broadcast to master schedule 
on the target controller. If the selected instance is a 
slave schedule, it can only be broadcasted to a slave 
schedule on the target controller.

3.	 Click the lightning bolt in front of the event properties 
that you wish to broadcast for an existing schedule 
event: 

Time Schedule

Broadcast Existing Schedule Event

 
A master schedule event cannot be configured as 
relative time. 
 
If the schedule event of which event number is existing 
on the target controller, then the event will be updated. 
If not, the update will not be applied to the event on the 
target controller. 
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For example: A user would like to apply Events 2 
properties to the target controller, but on the target 
controller, the Events 2 do not exist, then the change 
will not be applied. 
 

Events for Time Schedule

If you want to add a new event and broadcast it, you 
need to increase the Number of Events in the General 
tab, then configure all mandatory properties for the 
newly added event, check all the lighting bolts for the 
newly added events for broadcast. 
 
If the event number on the target controller has been 
occupied, it will overwrite all the properties for the 
relative event, if not, the newly added event will be 
broadcasted to the target controller as a new event.

4.	 Select the newly added time schedule Application Setpoint Group. Add a new Target Controller Group of time 
schedule from the Target Controller Group window by filtering the Application Type using a Time Schedule.

Target Controller Group

5.	 Select the Target Controller Group and click Go. The Time Schedule will be broadcasted: 

Selecting the Target Controller Group
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Case Controller Setting Configuration

1.	 Add a new Circuit (Standard) Application Setpoint 
Group and provide a name:

Case Control

2.	 Select a Circuit (Standard) instance from the simulative 
tree.

Circuit Standard

3.	 Click the lightning bolt in front of the point that you wish 
to broadcast:

Lead Circuit

4.	 Select the newly added Circuit (Standard) Application 
Setpoint Group. Add a new Target Controller Group 
of Circuit (Standard) from Target Controller Group 
window, by filtering the Application Type using a Case 
Controller Type such as Circuit (Standard).

Case Controller Type

5.	 Select the Target Controller group and click Go. The Circuits will be broadcasted:

Selecting Target Controller Group
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12.6.4   Point Setpoint Broadcast

Point Configuration Broadcast changes the setpoint broadcast approach to sending a point configuration.

When the Point Configuration Broadcast button is clicked, the Application Setpoint Group changes to Point Configuration 
Group and Target Point Group. Setpoint Configuration can be configured separately at the point level. Right-click a point in the 
tree to open the Activity Startup page and the Point Configuration Group pop-up where you can enter a name for the point 
and select Analog or Digital.

Choose Change Template 

Once you have chosen Point Configuration Broadcast, click Add New:

Point Configuration Broadcast

You can choose Analog or Digital from the Type  
drop-down. Click Save to jump to the point selection 
window to start compiling your Change Template:

Configure Advisory or Log configuration in Point 
Configuration Group page.

Select Point Configure Advisory
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After configuration is done, click Save and the Change 
Template is saved using the name you provided:

Choose Target Controller Group 

You can choose existing Target Point Groups, or you can  
Add New:

Log Configuration

Demo/Analog

Adding New Target Point Group

Provide a Target Point Group name and select Type. The 
type could be Analog, Digital, or both.

File Naming

Choosing Target Point

Save the Target Controller Group as an entry:

Changing Template and Target Point Group

Choose Change Template and Target Point Group and  
Click Go (Run Now) or Apply (Run on Schedule).

Click Save and then choose a target point for broadcast.
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12.6.5   Review Setpoint Broadcast Schedule

You can review your Setpoint Broadcast Schedule with the Schedule Assistant. Select Setpoint > Setpoint Broadcast > 
Configure Setpoint Broadcast:

Schedule Assistant

You will see a calendar-based schedule for clarification:

Schedule Summary

12.6.6   Review Setpoint Broadcast History

Select Setpoints > Setpoint Broadcast > Setpoint Broadcast History from the top menu to view the Setpoint Broadcast 
activity history result.

Schedule Broadcast Activity Result
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Click the Show Detail button to see the points detail which has been broadcasted.

Changed From: The original value of the point

Changed To: The target value of the point.

Test Send Only: If theTest Send is Yes, that means the activity is executed to connect the device and retrieve any information 
needed to test for valid points, but the value will not actually change. 

12.6.7  Revert Setpoint Broadcast

If the user wants to revert the points value which has been broadcasted, click the Revert button of the activity.

The Revert button will only show when broadcast activity is completed or partially completed.

After clicking the Revert button, it will jump to Revert Activity page.

Show Details

Revert

Revert Activity
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You can check the check box in front of each item (Revert activity is based on application instance level, you should revert all 
the broadcasted points value of selected application instance. It will not able to select one point to revert), then click Revert 
Changes button, a confirmation message will appear. Click Yes to continue the revert.

Once the revert is completed, the reverted instance will be disappeared from Revert Activity table.

The Revert button in the Setpoint Broadcast Activity page will show as Partially Reverted or Reverted after reverting.

Partially Reverted: It indicates that you just selected a parts of the instances to revert, or the revert activity is partially 
completed. You can expend “+” of activity to view the detail.

Reverted: Indicate all the points of the broadcasted instances have been reverted.

NOTE: User access of Site Supervisor and E3 cannot be reverted.
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12.7.1   Add a New Schedule

When adding a new schedule, you can choose Run Now. The activity would just run once.

You can also choose Run On Schedule and specify the days/hours that you want this activity to run.

Add a New Schedule

Activity Startup

12.7   Schedule Controller Activity

When you perform an activity from the Navigation Tree/Graphical Screen/Watch Point right-click menu, you start a Run 
Once activity. You can also schedule a recurring controller activity from the top Header Menu > Activity. You can add a new 
Schedule by accessing Schedule Manager > Add New.
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12.7.2   Schedule Manager

After completing the configuration, you will see your schedule on the Schedule Manager table. In this table, the schedule’s 
Next Run Time will be converted to the server time based on the configuration you configured above.

Schedule Manager

View Schedule

When you choose Run On Schedule, you will need to fill in the schedule name and choose the desired activity type. Configure 
the activity start/end time under schedule section. You will notice that the time zone is displayed as the server time zone, but 
pre-filled Start Date/Time is your browser time when you open this page. You need to configure a future time based on your 
browser time to make sure the schedule can be configured successfully.  
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12.7.3   Schedule Assistant

12.8   View Activities Status

You can check the Activity Status in Activity History whether the activity is started from any menu or if it is Run Once or  
Run On Schedule. You can access Activity History from the top menu or right-click menu at each Navigation Tree Level.

Schedule Assistant

Pending Activities
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Field Name Description

Activity
An activity includes all system and user-performed activities in Connect+. You may see some activities you that 
may not have been performed, such as Get Point Value. These activities can be called by other activities that have 
been performed such as Retrieve Logs.

Started Time when the activity has been started.

Duration How long it takes Connect+ to perform the activity.

User Who performed this activity.

Target Directory/Site/Control System/Units/Application Type/Application/Points ***see below explanation for compound 
activity with multiple target.

Result In Progress, Complete, Partial Complete, Fail ***see below explanation for Partial Complete.

Exception Report When activities are partially complete or have failed, this report will include the reason for diagnosis.

Tips: Certain Activities are compound activity. For compound activities, you can expand the parent activity to check each 
children activity’s Target and Result. For example, Obtain Controller Information is an activity that contains Refresh Units, 
Refresh Application, and Refresh Point Lists. If you start Obtain Controller Information at the Directory Level, it will then apply 
to any site and controller. You would see and expanded list of sub-activities with Targets and Results. If any sub-activities have 
failed, the parent activity Result would be partially complete. 

Table 10: View Activities Status
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13.   Firmware Update

13.1   Firmware Management

Before updating the firmware, firmware and language 
packages on the Connect+ server can be uploaded and/
or deleted from File > Firmware Package Management 
at the Control System level on the navigation tree or Admin 
Tools > Firmware Package Management.

Firmware Package Management Menu

Firmware Package Management

The Firmware Package Manager page comprises the 
Firmware Packages and Language Packages tables 
where you can upload and/or delete firmware and language 
packages on the Connect+ server. Once the package is 
uploaded, it will be kept in the server until you manually 
delete it. You can update Firmware Package for E2, Site 
Supervisor and E3 and XWEB. Note that the Language 
Package is only available for E2 controllers with firmware 
versions 4.05 and above.

Firmware Package Manager
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Add Firmware

Click Add New to upload a firmware package to Connect+.

Adding Firmware

Select Controller Type

You can select E2, Site Supervisor and E3, or XWEB from 
Select Controller Type drop-down. Choose a firmware 
file to upload by clicking the Browse button on the Add 
Firmware Package window and select the desired file from 
the File Upload window.

You should upload a package file with the correct extension 
filename. Note that the extension of E2 package is .pkg., 
XWEB package extension is .zip., and the Site Supervisor 
and E3 package file does not have an extension, For 
example, SS_2.14A10_Firmware_Update. You might 
download the Site Supervisor and E3 package as the zip file, 
please unzips it before uploading it to Connect+.

After upload, you can see the uploaded package with 
firmware version and controller type listed in the table.

If the name extension is incorrect, a pop-up window will be 
displayed with the error message.

Delete Firmware

The delete firmware package function allows firmware 
package files to be removed from the Connect+ file system 
and database.

To remove firmware packages from the server, click the 
check box(es) of the package(s) you wish to delete and 
click the Delete button on the Firmware Packages table.

Firmware Package Management

After deleting, the package will be removed from table.
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Adding Language File

After upload, you can see package with language is displayed in the table.

Add Language File:

You can click Add New to upload a language package in Language Package table for E2.

Language Description

Delete Language File:

To remove firmware packages from the server, click the check box(es) of the language package(s) you wish to delete and click 
the Delete button on the Firmware Packages table.

13.2   Firmware Transfer

The Firmware Transfer process delivers the firmware files 
to the units in a control system and/or up-dates language 
package files of units. A Firmware Transfer can be started 
from a Directory, Site, or a Control System in the navigation 
tree File > Firmware Transfer or Firmware Transfer can be 
scheduled.

Firmware Transfer

Firmware Transfers may be scheduled, but will be on a 
non-recurring, one-time schedule only. This is because 
the controller can only keep one package, and once a 
package is transferred, it remains on the controller until it is 
applied. If you transfer another package before applying it, 
the previous package will be overwritten. So they will need 
to be configured in Schedule Manager each time when 
running on a schedule.

At the start of the Firmware Transfer, a Control System 
Inventory will be performed on the Control System(s) 
selected for Firmware Transfer.

If you have grouped controllers, the firmware will be 
transferred to the gateway unit, and then the gateway 
unit will be instructed to transfer to any other units that are 
members of the control system, one at a time.

Firmware transfer will not apply for XWEB. XWEB only needs 
to execute Firmware Apply to update the firmware version.
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Activity Startup

Firmware Transfer Selections:

Perform Firmware Transfer is checked by default. You 
can select the appropriate firmware package under the 
Firmware Selection drop-down list; this package is 
uploaded in Firmware Package Management as covered 
in the previous section. 

Firmware Transfer Selection

If the firmware selection is a downgrade for the selected 
control system, and it is acceptable for the downgrade 
to occur, select Yes from the Downgrade Allowed drop-
down list. If No is selected and the firmware transfer is a 
downgrade for the control system, the firmware transfer 
will not occur. As a precaution, a warning will appear in the 
Activity History page when a unit is receiving a package that 
will be a downgrade to its firmware.

Language Package Options

If you wish to perform a language package update only, 
disable the Perform Firmware Transfer check box.

After the configuration is complete, click Go to execute the 
activity. The Activity Status page will open and show the 
progress of the activity:

Language Package Options:

If you wish to run a language file update simultaneously with 
a firmware transfer, enable the Update Language Package 
check box under Language Package Options, and then 
select the language file to update from the Language 
Package drop-down list (all language package file names 
on the server will display in this list):
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Firmware Transfer Page

The detailed progress of the Firmware Transfer can be 
monitored from the Activity History page Top Menu > 
Activities > Activity History > My Activity History.

Language package files are transferred from control system 
to control system. During the update process, Connect+ will 
check the firmware version of each unit in the target control 
system if supported and compatible with the language 
package version. If the unit is supported and compatible, 
the update will proceed for that unit. Otherwise, the update 
will be skipped on the unsupported unit and the next 
unit will be checked for version compatibility. The update 
process will continue to run until all units in all target control 
systems have been checked and/or updated.

Controllers must be rebooted, and the language must be 
selected for the update to take effect.

13.3   Firmware Apply

A Firmware Apply can be started from a Directory, Site, or 
a Control System in the navigation tree File > Firmware 
Transfer.

Firmware Apply

Activity Startup

The Backup Control System before Apply drop-down 
will perform a backup of units in the Control System before 
the firmware is applied if the option is set to Yes. The default 
value will be No.

Warning Prompt

Note that the Cancel Apply If Battery Test Failed option is 
only for E2. If it is set to Yes, a battery test will be performed 
on all units prior to applying the firmware. If any unit fails 
the battery test, the Firmware Apply will automatically be 
canceled, and the Activity Details report will be updated to 
show that the apply process was canceled as a result of the 
battery test failure of the applicable units.

When you execute Firmware Apply for Site Supervisor and 
E3, you will see Cancel Apply If Battery Test Failed option 
is set to No and is non-editable.

Select a firmware version from the Firmware Selection 
drop-down.

When you are ready to initiate the Firmware Apply activity, 
click Go. The activity will begin.

The Firmware Apply activity will connect to the targeted 
Control System and validate the firmware

file on each controller of the control system. If any firmware 
file fails validation, the firmware apply for

the target control system will fail and report the failure in the 
activity history.

If Downgrade Allowed is set to Yes, a warning message 
will be displayed alerting that the unit(s) existing setpoints 
will be cleaned out as a result of downgrading the firmware. 
Click Proceed to proceed with the downgrade or Cancel to 
stop.
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14.   Configure Data Retention

When your system runs for a very long time, there might be 
a great deal of data in your database that can cause your 
system to run slowly. At this time, you can purge the old 
and unused data from the database to reduce the database 
burden.

14.1   Configure Log Purge

Controller point log data is stored in the database but can 
be deleted with the Configure Log Purge feature. The Log 
Purge function can help you calculate the old log data 
based on your configuration or delete the old log data.

The Configure Log Purge page allows you to set parameters 
for the Log Purge activity. Right-click from any level of the 
navigation tree, select File > Configure Log Purge.

Configure Log Purge

Log Purge Activity

The default selection is Keep logs forever (do not delete). For this selection, log data will be kept permanently in the 
database.
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You can delete or compact logs by selecting the radio button:

•	 Delete Logs with date values older than specified number of weeks: 
 

Deleting Logs

Select Number of weeks to keep from the drop-down list, 1 to 156 can be selected to keep. After your selection, the system will keep the 
latest selection week’s data and the data older than the configuration will be deleted from database.

•	 Compact log data based on the following rules:

Compact Log Data

•	 Data older than: If Now is selected, logs older than the current 
date will be compacted based on the rules that you specify 
thereafter. If Specified Number of Weeks is chosen, select 
a number from the Number of weeks keep drop-down. 
The data older than the specified number of weeks will be 
compacted.

•	 Number of weeks keep: Select a number (1-156) from the list. 
This option will hide when the Data older than rule is set to 
Now.

•	 Based on: (the method of compaction) 
 
AVERAGE: Log values for the established time period will be 
added and the sum of all values will be divided by the number 
of logs 
 
MAXIMUM: Over the set period of time, the log with the highest 
(max) value will be stored. 
 
MINIMUM: Over the set period of time, the log with the lowest 
(min) value will be stored. 
 
Example: Logs recorded were 10, 20, 10, and 10. Compaction 
by AVERAGE will yield a log value of 12.5. Compaction by 
MAXIMUM will yield a log value of 20 and a value of 10 if by 
MINIMUM.

•	 Over a/Period: Logs will be compacted depending on these 
settings. It can be set as Minutes, Hours or Days. Specify the 
amount of time for compression of the Average, Maximum, or 
Minimum values. Select a unit of time from the Period drop-
down and choose a number from the Over a drop-down.

Click Save to save the settings and exit or Cancel to exit the 
page without saving.

Example of Compacting Log Data

Data Source: Consider the following log data for 
compaction.

Date and Time Recorded Value

April 1, 2010 12:00pm 10

April 1, 2010 12:15pm 20

April 1, 2010 12:30pm 10

April 1, 2010 12:45pm 20

April 1, 2010 01:00pm 40

April 1, 2010 01:15pm 5

April 1, 2010 01:30pm 15

April 1, 2010 01:45pm 35

April 1, 2010 02:00pm 10
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Example 1: Assuming that compaction is to be carried out 
based on the Average and the established time period is 1 
hour, the following log values will be stored in the database:

Date and Time Reduced Value

April 1, 2010 12:00pm 15

April 1, 2010 01:00pm 23.75

Calculate steps:

1.	 Log values that were recorded for the first hour will be 
grouped together and compressed by Average. That is: 
(10 + 20 + 10 + 20) / 4 = 15.

2.	 The equivalent value, which is 15, will be stored in the 
database; old values (10, 20, 10, and 20) will be purged.

3.	 For the next hour, log values will be compressed, (40 + 
5 + 15 + 35) / 4 = 23.75.

4.	 The compressed value (23.75) will be stored and old 
values (40, 5, 15, and 35) will be purged.

Example 2: If data compaction is to be carried out based on 
the Minimum and the established time period is 45 minutes, 
the source data will be compacted as below result:

Date and Time Reduced Value

April 1, 2010 12:00pm 10

April 1, 2010 12:45pm 5

April 1, 2010 01:30pm 10

Calculate steps:

1.	 Log values that were recorded for the first 45 minutes 
will be grouped together.

2.	 The minimum value in the first 45 minutes, that is 10, will 
be stored in the database; old values (10, 20, 10) will be 
purged.

3.	 For the next 45 minutes, log values will be stored as 
lowest value 5, and old values (20, 40, 5) will be purged.

4.	 For the last 45 minutes, log values will be stored as 
lowest value 10, and old values (15, 35, 10) will be 
purged.

Example 3: Same rules apply for compaction by Maximum, 
the source data will be compacted as below result:

Date and Time Reduced Value

April 1, 2010 12:00pm 20

April 1, 2010 12:45pm 40

April 1, 2010 01:30pm 35

14.2   Configure Advisory Purge

Configure Advisory Purge allows you to set parameters 
for advisories. Right-click on a navigation tree on directory, 
site, control system, or unit level and select Advisories > 
Configure Advisory Purge to open the page.

Configure Advisory Purge

The default setting of keeping advisories forever (advisories 
are never deleted) is the first Activity Item on this page and 
can also be set from the second radio button under “OR”.

Configure Advisory Purge Page
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When selecting the second radio button, you can choose 
Specified number of weeks or Specified number of 
months from Delete values order than drop-down list. 
Once it is selected, Number of weeks to keep or Number 
of months to keep field will be displayed. You can enter 
the number to keep the latest configured weeks or months 
advisories. Click the Save button once the configuration 
has completed.

The advisory will be purged after the system schedule 
AdvisoryPurgeJob run, and the default schedule will run 
every 2 hours. You can check the schedule from schedule 
manager.

14.3   Configure Advisory Snooze

Advisory Snooze Configuration allows you to set an alarm 
wait time (a Snooze alarm) to reduce the total amount 
of recurring advisories in the database. Right-click on 
a navigation tree of each level and select Advisories > 
Configure Advisory Snooze to open the page.

Configure Advisory Snooze

The default setting of keeping advisories forever (advisories 
are never deleted) is the first Activity Item on this page and 
can also be set from the second radio button under “OR”.

Configure Advisory Snooze Page

Snooze configuration will set the snooze time for a historical 
advisory.

The default configuration is 6 hours. Set your own 
configuration from the drop-down list under the “OR” 
section. You can choose Never, Minute(s) or Hour(s) 
from Snooze for duration drop-down list. Once it is set as 
Minute(s) or Hour(s), Number of minutes to snooze or 
Number of hours to snooze field will be display. You can 
enter the number of minutes or hours in the field depending 
on which one you select. The default value for hours and 
minutes is 6.

Once sent, a snoozed advisory will not be sent to the 
monitoring server again until the Snooze has expired and 
the advisory is still active. The advisory will then be resent to 
the monitoring server as a new advisory.

Click Save to save changes and see the confirmation 
screen. Click Cancel to exit.

14.4   Configure Inbound Connection  
   Purge 

Controllers contact Monitoring once a day to verify the 
controller connection and record connection information in 
Connection Verification Report. 

You can choose to purge the records in Connection 
Verification Report from Top Menu > Advisories > Purge 
Inbound Connections.

Purge Inbound Connections
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The default setting of connection purge is Forever (do not delete). It can keep all records for this option.

Purge Inbound Connections Records

With the Purge Inbound Connection Records, you can set purge configurations for these inbound connection records. Choose 
Specified number of weeks or Specified number of months to keep the latest time period of weeks or months.

If you choose to purge a specific number of connection records, specify either weeks or months from the drop-down list and 
enter the specific number into the Number of weeks/months to keep field. Enter the time of day to remove the older items in 
the spaces provided and click Save to save changes or Cancel to exit the screen.

Purge Inbound Connections Prompt

The inbound connection will be purged after the system schedule InboundAdvisoryQueueToAdvisoryJob run, and the 
default schedule will run every 1 minute. You can check the schedule from schedule manager.
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15.   Reports

Connect+ has different reports that help you summarize and 
analysis your data. 

Advisory Analysis and Energy Analysis reports can 
provide the intuitive energy consumption and the complete 
picture of alarm information about the region and site.

Alarm Summary and Insights Enterprise reports can 
analysis the data from a variety of perspectives to help you 
pinpoint problems quickly. Both reports require additional 
purchases.

If these reports are not showing for your directory and site, 
contact your administrator.

Advisory Analysis

You will see the advisories summarized and displayed in the following dashboard. It will show last 24 hours advisories by 
default.

Reporting View

15.1   Advisory Analysis Report

Select Reporting > Advisory Analysis from right-click menu of the directory.
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You can change the date or date range from the date selection field and the report will be displayed according to the selected 
date range. Chart and the table will be grouped per site per day.  

You can change the graph UI by clicking the graph icons. 

And in the table, you could expand the arrow ahead of each item to view next level detail in the table. Filter or sort the column

 
by clicking the icon next to the column name.

Table View

In the report, you might see Controller Not Sending Alarms since last received time advisory displayed without App Type. 
This is because the advisory is generated for the controller, and not for a specific application type.

Controller Not Sending Alarms Message
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15.2   Energy Analysis Report

The Energy Analysis Report is available from the directory and site levels. Right-click on directory or site, select Reporting > 
Energy Analysis Report for Directory or Energy Analysis Report for Site.

Energy Analysis Report

Data Filter

The report presents data through charts and tables. Bar charts shows the summary of energy data for each date, and you can 
view detailed daily data for each application instance at each site in the table.

You can filter the date, directory and site from the top of the report, and reset them by clicking the Reset button if needed.
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Hover on the upper right corner of each graph or table, you can filter, sort, export or customize the configuration by selecting 
the action menu.

Legend Configuration

Legend Configuration
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15.3   Alarm Summary Report

Select Top Menu > Reporting > Alarm Summary Report, you will see the report. 

The report defaults to showing a summary of the alarms and displays the last 45 days of data. You can change the date filter 
from the top.

In the Alarm Summary page, each section displays the alarms with a different view and shows their meaning on the left side, 
so you can easily understand what each chart and table data means.

You can filter, view detail data and export the data by clicking the icon on the upper right of each section.

If you want to see detailed information for each site, you can change the tab at the bottom of the report. Filter the desired 
criteria from the top and the detailed data will be displayed on the next image.
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Field Name Description

Alarms Today Shows the total alarm number for today.

Alarm Yesterday Shows the total alarm number for yesterday.

Per Day WkTD Shows the average alarm number for a period time from the beginning of the current calendar week to the end 
of the current date.

Per Day LW Shows the average alarm number of last week.

Per Day MTD Shows the average alarm number for a period time from the beginning of the current month to the end of the 
current date.

Per Day PM Shows the average alarm number of past month.

From this page, you can download the entire report for this alarm detail by clicking the Download as PDF button at the top.  
As with other reports, you can also export the data for each chart or table from the top right corner of each section.

To export the entire report, you can click on the icon at the bottom left of the report and then select Entire Workbook from the 
Attachments drop-down menu.          
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15.4  	Insight Enterprise Report

This report can be seen by selecting Top Menu > Reporting > Insight Enterprise Report. The report calculates the data to 
analysis whether a case or rack device is healthy or not, and categorizes the data according to enterprise, site and asset level, 
you can switch them at the bottom of the report.

The definitions of Enterprise tab in the report help you understand what the main items mean.
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Data marked in red indicates that the target is not meeting expectations, and you need to pay attention to that.

You can go the Site or Asset page to filter and view the specific site data.

In Site and Asset tab, you can filter the site and case you are concerned about from the top. 

You can customize the view, sort or export the data for this section from the menu in the upper right corner of each section.

If you want to export the whole data, click the icon at the bottom left of the report and then select Entire Workbook from the 
Attachments drop-down menu.
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16.   Global Search

When a site is configured as the Site Home Screen, 
you can search the home screen by filling in the 
site name.

Do not click the search button and wait for the 
site’s home screen name to show up like a drop-
down item, by clicking the site home screen name, 
you can be directed to that site’s Home Screen 
directly.

Search Field

Site Home Page

Search Result

A search can be performed by entering criteria into 
the search field (look for the magnifying glass) on 
the Connect+ header. You can search for a site’s 
home screen, or for a specific directories, sites, 
controllers, devices or points. Clicking search icon 
        to search for the relative tree nodes.
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17.   Audit Log

You can have an  overall information about the user login/logout and Connect+ management in Audit Log page.

Select Header Menu > Activity > Audit Log. You will see Past 7 days data by default. 

Audit Log

Event Type Action Taken Details

User Sessions

Login Login

Show the browser and version, operation system and 
version, IP address.Logout

User Logout

Auto Logout

User Group Administration

Create
Group Describe which group is created or deleted.

Delete

Modify Group Configuration Describe what information is modified.

User Administration

Modify Group Access Describe the group change.

Create
User Describe which user is created or deleted.

Delete

Modify User Configuration Describe what information is modified.

Modify Password Password change record. The password is encrypted.

Site Manager

Create

Site Describe which site is created, modified or deleted.Modify

Delete

Directory Manager

Create

Directory Describe which directory is created, modified or 
deleted.Modify

Delete
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Appendix A: Summary of Export Capability

Appendix B: System Summary Screens

Data to Export Connect+ Page UI Access

Advisories Advisory View Toolbar Menu and Navigation Tree

Live Advisories Live Advisory Tree Control System

Log Data

Watch Points Watch Point Page

Log Graph
Advisories View > Log Graph  > Setting
Watch Points  > Log Graph  > Setting
Graphical Screens  > Log Graph  > Setting

Connection Verification 
Report Site not Sending Alarms Toolbar Menu

Enterprise Summary Enterprise Summary Toolbar Menu

Connect+ Page UI Access

Refrigerant Summary Site

Building Summary Site

Other Summary Site

Summary (Controller) Unit

Summary (Application) Application Type

Defrost Summary Application Type

Graphical Status Application Instance

Status Application Instance

Summary of Export

System Summary Screens
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Site Level: Refrigeration Summary

Site Level: Building Summary
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Site Level: Other Summary

Controller Unit Level: Controller Summary
Building Controller Summary
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Ref Controller Summary

Application Type Level: Summary Screens
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Application Instance Level: Status Screen & Graphical Status
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